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1. Overview of using the ECAD Viewer
Teamcenter lifecycle visualization is the application used by collaborators who do not have access to
your corporate database. ECAD documents are imported from and exported to both applications to
improve collaboration while maintaining database integrity. To use the ECAD Viewer, you must install
Teamcenter lifecycle visualization. Refer to the Add lifecycle visualization to the Teamcenter rich client
topic in Installation in the Teamcenter help.

The ECAD Viewer (Electrical Computer Aided Design) supports the Printed Circuit Board (PCB) design
process by providing PCB and schematic viewing and markup tools and options. The PCB design and
manufacturing industry relies on numerous CAD software programs that help designers create printed
circuit boards. These native PCB and schematic files must first be translated to a neutral file format before
they can be processed and opened in the viewer.

As a result, one of the first steps to consider before you work with the ECAD Viewer is to make sure your
native CAD files are translated to the XFATF or XSCH neutral file format. However, it is possible that you
can skip this step if your system administrator has already translated your data.

Using Teamcenter engineering process management, your team can translate over 30 PCB file formats,
including those supplied by Cadence, Mentor Graphics, and Zuken, to a neutral file format that can be
opened and manipulated in the ECAD Viewer. You can also translate EDIF 2.0 and 3.0 schematic file
formats to the neutral file format. The software provides you with a rich set of viewing tools, including
net and page connector navigation. You can quickly search for various PCB or schematic components.
The software includes detailed annotation (markup) tools to help you communicate and collaborate
during the PCB design lifecycle, which includes pre-translated vocabulary listings. Plus, you can select
existing markup text or create your own common messages that can be included as markups during the
design process.

Cross probing, detailed measurement markups (distance, radial, clearance, Manhattan length and
routed length), creating reports, printing, and working with Design for Assembly standards are tools
and features that are also included with the ECAD Viewer.

Tip:

Use the tutorial to get a practical understanding of many basic features and functions included
with the ECAD Viewer.
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2. Getting started with the ECAD Viewer
ECAD Viewer interface

Overview of the ECAD Viewer interface

The ECAD Viewer user interface includes several viewing frames, toolbars, and shortcut menu options.
This section offers a brief introduction to these navigation and command option tools.

The ECAD Viewer interface appears when you open an ECAD document.

To activate ECAD toolbars, right-click the area just above the Viewing window to open a list of toolbars.
Select and clear the toolbars as needed. The tasks you perform dictate which user interface frames that
are exposed. Each frame contains shortcut menus that provide easy access to options associated with
that user interface section. You access shortcut menu options by right-clicking inside a specific viewing
section.

Introduction to ECAD toolbars

Exploring ECAD toolbars

Toolbars provide quick access to most ECAD options and features that you use to achieve collaborative
design results. Toolbars help you with viewing options, markup tools, net navigation rendering, printing,
creating reports, and cross probing reviews between a PCB and its associated schematic.

ECAD Viewing toolbar

Use the ECAD Viewing toolbar to quickly manage or change how you view ECAD documents.

Use this option To do this

Fit All Fit the entire design into the Viewing window.

Base View Size the view to the extents of the PCB dimensions.

Browse Display the name of ECAD objects as you move the cursor
around the Viewing window.

Zoom Area Zoom to a specific area of the document.
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Use this option To do this

Seek Center a point on the document.

Pan Move the document around the Viewing window.

Zoom Move closer to or farther from the document.

Zoom In Move the document closer to your view.

Zoom Out Move the document farther from your view.

Rotate Counterclockwise Rotate the document 90 degrees counterclockwise.

Rotate Clockwise Rotate the document 90 degrees clockwise.

Flip Horizontal Flip the document 180 degrees horizontally.

Flip Vertical Flip the document to a vertical position.

Copy image Copy the image in the Viewing window to the clipboard.

Copy region Copy a section of the image to the clipboard.

Snapshots toolbar

Use the Snapshots toolbar to add and manipulate snapshots that are displayed.

Use this option To do this

Add Add a snapshot of the Viewing window.

Insert Insert a snapshot between two existing snapshots.

Delete Delete the selected snapshot.

Replace Replace the selected snapshot with a snapshot of the
Viewing window.

2. Getting started with the ECAD Viewer
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Note:

The Toggle View and Preferences options are only supported by 3D snapshots.

ECAD Base toolbar

Use the ECAD Base toolbar to manage specific ECAD functionality such as specifying side views,
changing layer characteristics, navigating nets, creating reports, and setting cross probing for both the
PCB and schematic.

Use this option To do this

View Top and Bottom Side Specify the order in which you view document layers.

View Opposite Side View the top or bottom side depending on the side that is
currently showing.

Layer Color Change layer colors and layer visibility states. Use the Layer
Color dialog box to manage these options.

Search Search for objects by using the options associated with the
Search dialog box.

Create Report Open the Reports dialog box to create and run various ECAD
reports.

Cross Probe Explore both the PCB and schematic in one Viewing window.

Previous Move the net marker to the previous point in navigating the
net.

Next Move the net marker to the next point in navigating the net.

Visual Compare Compare the differences between two ECAD documents.

PCB Properties Display document property data by using the Properties
dialog box.

ECAD Markup toolbar

Use the ECAD Markup toolbar options to manage how you want to mark up ECAD documents. In most
cases, markup support applies to both the PCB and schematic documents.

ECAD Base toolbar
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Use this option To do this

Enable Markup Activate and deactivate the ECAD markup feature.

Create New Markup Open the Markup Topic dialog box. After selecting this
option, click in the Viewing window and enter a markup
topic.

Select Markup Select a markup that is displayed in the Viewing window.

Freehand Line Draw a freehand line.

Leader Line Draw a straight line and optionally add leader ends to the
line.

Ellipse Draw an ellipse or circle on the ECAD document.

Polygon Draw a polygon on the ECAD document.

Rectangle Draw a rectangle or a square on the ECAD document.

Text Open the Text Editor dialog box and add text markups.

Rubber Stamp Open the Rubber Stamp dialog box. Select either
auto-translate selected predefined text or select existing
predefined text from a note file.

Distance Measurement (PCB only) Measure the distance between one point to
another point, between one point to a specific location on
a line, or between one line and another line.

Radial Measurement (PCB only) Measure the radial distance on any ring or circle.

Clearance Measurement (PCB only) Measure the minimum distance between two
objects.

Manhattan Length (PCB only) Measure the distance between any point along
the trace and via contained within the same net.

Note:

Manhattan length refers to the sum of the X- and Y-
distances between the two selected points.

2. Getting started with the ECAD Viewer
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Use this option To do this

Routed Length (PCB only) Measure the distance between any point along
the trace and via contained within the same net.

Note:

Routed length refers to sum of each segment along
the trace between the two selected points.

Markup Log Open the Markup Log dialog box to display markup activity
related to the ECAD document.

Save Markups Save the markup in the established dataset.

Save Markups As Save the markup in a different dataset.

Markup Profile Preferences Display the Markup Profiles dialog box which contains
markup profile names and markup preferences.

ECAD DFx toolbar

Use the DFx toolbar to manage how you want to evaluate and analyze your designs against
manufacturing rules.

Use this option To do this

Open Rules File Open the Open Rules dialog box and select a configuration
file containing the rules for evaluating the open PCB.

Edit Rules File Open the DFx Rule Set Editor dialog box to review and
modify Design for Assembly and Design for Test rules.

Open Results File Open a previously generated results file for the current PCB.

Save DFx Files Save the active rules file and results using the current dataset
name.

Save DFx Files As Save the active rules file and results. You will be prompted
for a new dataset name.

Run DFx Rules Start the design evaluation on the active PCB.

ECAD DFx toolbar
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Use this option To do this

Display DFx Summary
Report

Open the most recently saved summary results report for the
active PCB.

Display DFx Detail Report Open the most recently saved detail results report for the
active PCB.

Note:

Most of these options require a DFx authoring license.

ECAD Multipage toolbar

Use the ECAD Multipage toolbar to navigate among pages in a multipage ECAD document.

Use this option To do this

First Page Go to the first page in a multipage file.

Previous Page Go to the previous page in a multipage file.

Go To Page Go to a specific page in a multipage file.

Last Page Go to the last page in a multipage file.

Next Page Go to the next page in a multipage file.

Introduction to ECAD shortcut menus

Exploring shortcut menus

Shortcut menus appear when you right-click specific sections of the ECAD interface. Use shortcut
menus to quickly access features and functionality to help you work with many aspects affecting ECAD
document review and collaboration. Different shortcut menus are displayed depending on what you are
doing and where you are in the interface.

Markup shortcut menu

Use the Markup shortcut menu to edit markups, manipulate markup locations, and modify markup
properties.

2. Getting started with the ECAD Viewer
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Use this
option To do this

Add to This
Revision

Add markup revisions to any markup.

New
Revision

Prepare to move a markup by putting its content on the clipboard.

Edit Topic Copy the contents of the markup to the clipboard.

Iconize Display expanded and selected markups as icons.

Expand Display icon markups as fully expanded text.

Delete Highlight and delete selected markups.

Edit Text Add a markup to the PCB image.

Select All Select all markups. This option is unavailable if a markup is already highlighted.

Properties Display the markup properties (color, fill, font, and so forth) of one or more selected
markups. If you authored the markup, you can change the markup properties;
otherwise, the properties are view only.

Viewing shortcut menu

Use the Viewing shortcut menu to change how the ECAD document is displayed. For example, use it to
change layer colors, viewing preferences, and properties.

Use this
option To do this

Fit All Fit the entire design into the Viewing window.

Base View Size the view to the extents of the ECAD dimensions.

Browse Display the name of ECAD objects as you move the cursor around the Viewing window.

Zoom Area Zoom to a specific area of the document.

Seek Center a point of the design.

Pan Move the board around the Viewing window.

Zoom Move closer to or farther from the design.

Preferences Change how designs are viewed and loaded into the Viewing window. When you click
this option, you open the Preferences dialog box.

Viewing shortcut menu
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Use this
option To do this

Layer Color Change layer colors. When you click this option, you open the Layer Color dialog box.

Properties Display metadata about this design. When you click this option, you open the
Properties dialog box.

ECAD Layers shortcut menu

Use the ECAD Layers shortcut menu options to easily change how you manage and display markups.
The top level of the ECAD Layers page displays the dataset name and revision of the opened file.

Use this
option To do this

Save
Markups

Save your markup by overwriting the current markup dataset.

Save
Markups As

Save your markup and with a new dataset name.

Note:

The existing dataset can be overwritten.

Unload
Markups

Remove markups from the Viewing window. Unsaved markups will be deleted unless
you choose to save them.

Expand Expand entries in the ECAD Layers view.

Collapse Collapse entries in the ECAD Layers view.

All Markups
On

Turn on all markups.

All Markups
Off

Turn off all markups.

Expand
Markups

Expand all markups.

Collapse
Markups

Collapse all markups.

Find Find markups.

Reset
Visibility
State

Reset layers to the initial view.

2. Getting started with the ECAD Viewer
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Assembly view shortcut menu

Use the Assembly view shortcut menu options to easily display additional component details and to find
component layer objects.

Use this
option To do this

Attributes Open the Attributes dialog box, which displays additional component details.

Expand Point to and expand an object that contains sub-objects (noted by a plus sign to the
left of the object).

Collapse Point to and collapse an object that contains sub-objects (noted by a minus sign to the
left of the object).

Find Display the Find dialog box and enter objects of interest.

Instances Display the instance of part data and shapes contained in the ECAD document.

ECAD compare shortcut menu

Use the Compare view shortcut menu options to highlight and view entity differences between two
ECAD documents.

Use this
option To do this

Expand Point to and expand an object that contains sub-objects (noted by a plus sign to the
left of the object).

Collapse Point to and collapse an object that contains sub-objects (noted by a minus sign to the
left of the object).

Stop
Compare

End the compare instance and delete all data in the Compare view.

View
Differences

List differences between the two ECAD entities and, when selected, display the
individual element in the Viewing window.

Note:

Layers are turned off. To turn layers on, select Reset Visibility State.

Find Display the Find dialog box and enter objects of interest.

Reset
Visibility
State

Return the viewing mode to the state it was in prior to selecting View Differences.

Assembly view shortcut menu
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DFx shortcut menu

The DFx view displays two distinct sections – the rules and the results sections. These sections help
to manage and view DFx evaluation outcomes. Each section contains a shortcut menu that is slightly
different. Use the DFx shortcut options to quickly manage how you work with tools for analyzing PCBs.

Use this
option To do this

Save Save the current rule and result file.

Note:

If working with an existing file, the report will be saved to the same file name. If
the file is new, the Save As dialog appears.

Save As Save the current rule and result file to a new dataset (ECADDFX).

Expand Highlight and expand the node structure.

Collapse Highlight and collapse the node structure.

Display expanded and selected markups as icons.

Turn All
Rules On

(If the rules were off) Turn all rules on so they are displayed in the view, along with
associated results, if any.

Note:

• Rules are on when the check box contains a red check mark. You can turn
individual rules on or off by clearing the check mark.

• Turning rules on or off helps to organize and display the results you want in
the view. This action does not modify or customize the test or results.

Turn All
Rules Off

Turn off all rules and results.

Find Find terms (text or numbers) associated with the rules tree data.

Use shortcut keys to navigate documents

You can use your keyboard to quickly modify the view of your ECAD document.

• Do one or more of the following:

• For PCB only:

2. Getting started with the ECAD Viewer
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Use this key To do this

t View the top PCB panel.

b View the bottom PCB panel.

• For schematic only:

Use this key To do this

Page Up Move to the previous page.

Page Down Move to the next page.

Home Move to the first page.

End Move to the last page.

n (If on a page connector) Move to the next page connector.

p (If on a page connector) Move to the previous page connector.

• For both PCB and schematic:

Use this key To do this

n Move to the next net navigation point.

p Move to the previous net navigation point.

r Rotate the image 90 degrees clockwise.

R Rotate the image 90 degrees counterclockwise.

Arrow keys Move the image incrementally in the direction of the arrow.

Note:

If a markup is selected, you will move the markup in the direction of the
arrows.

c Center the viewport in the Viewing window.

F View data which is both inside and outside the bounding box.

f View data only contained inside the bounding box.

Overview of the ECAD Views

Lifecycle Viewer displays separate ECAD Views that help you navigate, search, and work with PCB
designs, schematic representations, and design for assembly and test output.

Overview of the ECAD Views
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Assembly view

The Assembly view displays a hierarchical structure of PCB circuit items, components, nets, panel items,
part data, and shapes. To help visually recognize and identify PCB elements, it may be useful to review
the Assembly PCB icons that are displayed in the view.

The view for schematic designs includes hierarchical structure for components, nets, shapes, and page
views. For information on the icons associated with schematic designs, review the Assembly schematic
icons.

ECAD Layers view

The ECAD Layers view displays the various layers associated with the viewable PCB and schematic
document. You can modify layer preferences, for example visibility and layer color, and you can add an
annotation (markup) on individual layers.

It may be useful to review the meaning of the ECAD layer icons.

2. Getting started with the ECAD Viewer
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Compare view

Use the Compare view to display ECAD document differences between two opened ECAD documents.
You can display differences from one design revision to other revisions, and you can display differences
between a PCB and its schematic design. When you highlight differences on the Compare view, the
ECAD object is centered and highlighted in the Viewing window. You can also display differences by
selecting View Differences from the compare shortcut menu.

ECAD DFX view

The ECAD DFX view provides both customized and default rules or preferences that you set. The rules
are used to analyze specific characteristics of the designed PCB. The ECAD DFX view displays the rules
and the results of the analysis.

Overview of the ECAD Views
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Review the DFx icons associated with this view.

Object icons

Use the following icons to help visually understand objects that appear in the Assembly view, the ECAD
Layer view, and the ECAD DFX view.

PCB Assembly icons

PCB Assembly icons Icon description

Root node

Panel

Circuit

Circuit item

Panel item

Glue

Mark

Hole

Component

Nets

2. Getting started with the ECAD Viewer
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PCB Assembly icons Icon description

Pin

Test points

Vias

Nail

Edited nail

Offrule nail

Pin SMD

Pin THT

Unconnected pin

Invalid via

Invalid via with a nail

Valid via

Valid via with a nail

Via with a nail

Part data

Part number

Shapes

Shape

Object icons
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Schematic Assembly icons

Schematic Assembly
icons Icon description

Root node

Circuit

Circuit item

Schematic component

Schematic net

Schematic bus

Schematic pin

Ground – Power

Power

Ground

Part data

Part number

Shapes

Page views

Page item

Sheet references

Sheet

Connector

ECAD job – purpose

Page

2. Getting started with the ECAD Viewer
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Schematic Assembly
icons Icon description

Pagemark

Pages

ECAD layer icons

ECAD layer icons Icon description

Root node

A fully loaded and
visible layer

A fully loaded and
partially visible layer

A loaded layer that is
not visible

A locked layer

ECAD DFx icons

ECAD DFx icons Icon description

Circuit

Rules file

Rule preference

Unsaved results

Saved result report or
individual result

Rule group

Rule

DFA result

DFT result

Object icons
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ECAD DFx icons Icon description

Number of access per
net

Clearance does not
meet minimum

A selected and loaded
rule

An unloaded but
available rule

Open ECAD documents

From Teamcenter, you highlight the desired ECAD document to open, and then send it to the viewer.

1. From the specific Home folder location, find and highlight the desired ECAD dataset.

2. Right-click and choose Send to→Lifecycle Viewer.

3. (If necessary, show the ECAD views) Choose Window→Show View→Other. In the Visualization
section, highlight Assembly, ECAD DFX, and ECAD Layer.

4. Activate a desired toolbar by choosing Toolbars and select the toolbar of interest.

2. Getting started with the ECAD Viewer
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Note:

You may need to give focus to the Lifecycle Viewer by highlighting it in the view.

Supported PCB and EDIF files

Supported PCB CAD files

Cadence Allegro Mentor

CADES-G Mentor Expedition

Cadnetix / Cadnetix EDIF Valor ODB

Cad-ul Ariadne Orcad Layout for Windows

Computamation Vutrax Orcad Layout for DOS PCB386

ComputerVision Autoboard / THEDA PADS-Perform, PowerPCB, PADS-PCB

DDE ECAD, Superman DDE P-CAD PDIF

Dedale / DeCad Prisma

DIF (C-Link) Protel Protel DOS (2.8)

Docica Protel 3 for Windows

Encore PCB (Scicards) Tango

Gencad Tango Pro

Gencam Topcad

Harris EDA SCI-Cards CII Ultiboard

Hewlett-Packard PCDS VanGuard

IBM CBDS Version 4 Zuken-Redac Visula cadEpert

IBM CBDS Version 5, Unicad Zuken-Redac CR3000

Integra Zuken-Redac CR5000

Supported EDIF 2.0 and 3.0 schematic files

Cadence Allegro (capture, HDL) Zuken CR5000

Mentor Expedition (dx designer) Mentor Board Station

Cadence ORDAD (capture) Mentor PADS (dx designer)

Supported PCB and EDIF files
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Translating CAD files

Overview of translating CAD files

Numerous native CAD applications and associated file formats exist in the industry. Teamcenter viewers
can only process neutral CAD formats, and depending on the workflow of your environment, you may
need to translate native CAD PCB and schematic data to this neutral file format.

Note:

We recommend that you contact your system administrator to determine the specific translation
process for your company.

Translate CAD files to PCB neutral formats

Note:

For complete details about translation services, see Dispatcher ─ Deployment and Administration.

1. From My Teamcenter, select the Home folder to create a new subfolder.

2. Choose File→New→Folder and in the New Folder dialog box, enter a name for the folder, for
example my_pcb_folder.

The new folder appears within the Home folder structure.

3. Select the new folder to create a new item.

4. Choose File→New→Item and in the New Item dialog box, select PCBCircuit.

5. In the New Item dialog box, click Next, then click Assign to name the new item, for example
circuit, and then click Finish.

6. Click Close.

7. Expand the my_pcb_folder folder and select the circuit item revision.

2. Getting started with the ECAD Viewer
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Note:

The my_pcb_folder and circuit item revision are sample names.

8. Choose File→New→Dataset and in the New Dataset dialog box, select EDAGenPCBCAD as the
type for the new dataset.

9. Select Import to import your CAD specific PCB file.

10. In the Import File dialog box, select the CAD file you want to import into My Teamcenter and then
click Import.

11. Click OK to close the New Dataset dialog box and your file is imported as the new dataset type.

12. Select the imported revision and choose Translation Services→Translate to translate your CAD file
to the PCB neutral file type XFATF. Select the newly created EDAGenPCBCAD dataset.

13. In the Select translator for dataset dialog box, in the Provider section, select UGS.

14. In the Translator section, select a translator that can translate your native CAD file.

15. Click OK to start the translation process.

16. (Optional) Choose Translation Services→Translation Administrator Console to see the progress
of the various translation stages.

17. (Optional) In the Translation Request Administration dialog box, type an asterisk in the Service
section and then click Query.

Note:

The asterisk is a wildcard symbol.

18. Select the desired translation request item and click Refresh. Close this dialog box when the
translation is finished.

19. To display the new XFATF file, select the circuit node, right-click and choose Refresh.

Translate CAD files to PCB neutral formats
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The XFATF item revision appears in the Demo folder.

20. If the CAD file in a PCBCircuit item contains multiple PCB designs (for example, panelized circuits),
after translation the child items of the PCBCircuit item are created. Each child item contains
translated version of an individual PCB design.

Translate CAD files to Schematic neutral formats

Note:

For complete details about translation services, see Dispatcher ─ Deployment and Administration.

1. From My Teamcenter, select the Home folder to create a new subfolder.

2. Choose File→New→Folder and in the New Folder dialog box, enter a name for the folder, for
example my_ecad_folder.

The new folder appears within the Home folder structure.

3. Select the new folder to create a new item.

4. Choose File→New→Item and in the New Item dialog box, select PCBCircuit.

2. Getting started with the ECAD Viewer
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5. In the New Item dialog box, click Next, then click Assign to name the new item, for example
circuit, and then click Finish.

6. Click Close.

7. Expand the my_ecad_folder folder and select the circuit item revision.

Note:

The my_ecad_folder folder and circuit item revision are sample names.

8. Choose File→New→Dataset and in the New Dataset dialog box, select EDAGenSchem as the
type for the new dataset.

9. Select Import to import your CAD file.

10. In the Import File dialog box, select the CAD file you want to import into My Teamcenter and then
click Import.

11. Click OK to close the New Dataset dialog box and your file is imported as the new dataset type.

12. Select the imported revision and choose Translation Services→Translate to translate your CAD file
to the neutral format type XSCH. Select the newly created EDAGenSchem dataset.

13. In the Select translator for dataset dialog box, in the Provider section, select UGS.

14. In the Translator section, select a translator that can translate your native CAD file.

15. Click OK to start the translation process.

Translate CAD files to Schematic neutral formats
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16. (Optional) Choose Translation Services→Translation Administrator Console to see the progress
of the various translation stages.

17. (Optional) In the Translation Request Administration dialog box, type an asterisk in the Service
section and then click Query.

Note:

The asterisk is a wildcard symbol.

18. Select the desired translation request item and click Refresh. Close this dialog box when the
translation is finished.

19. To display the new XSCH file, select the circuit node, right-click and choose Refresh.

2. Getting started with the ECAD Viewer
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3. Viewing ECAD documents
Overview of viewing ECAD documents

Use the following options to help organize how you load and view ECAD documents. Whether you are
working with a PCB, a schematic, or with a PCB design analysis, use these options to quickly manipulate
the view so you can display the documents and work with them as needed. For example, numerous
viewing options exist when you open ECAD documents in the Assembly view, in the ECAD Layer view,
or when you want to view the rules and results of PCB analysis using the ECAD DFX view. In addition to
immediate, but temporary viewing preferences, you can also configure default preferences that load and
set viewing conditions for every document that you open.

Working with standard ECAD viewing options

Display the entire image in the Viewing window

On the ECAD Viewing toolbar, click Fit All .

The ECAD document, including data outside the bounding box, is displayed in the Viewing window.

Display the base view

Use the Base View option to hide markup images that are embedded outside the bounding box.

• On the ECAD Viewing toolbar, click Base View .

Rotate the view

You may find it helpful to rotate the ECAD document in order to get a better view of specific objects.

On the ECAD Viewing toolbar, choose one of the following rotation tools:

• Rotate Counterclockwise  or Rotate Clockwise 

The view rotates by 90 degrees.

• Flip Horizontal  or Flip Vertical 

A mirror image of the board is displayed in the Viewing window.
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Move the entire image around the Viewing window

1. On the ECAD Viewing toolbar, click Pan .

2. From inside the Viewing window, drag the image to the desired position.

Tip:

Quickly change to the zoom mode by holding Shift and moving the right mouse button.

Change the center point of the view

You may need to move the center of focus so that you improve the view of various image areas.

1. On the ECAD Viewing toolbar, click Seek .

2. Click the desired point on the image.

The point you select becomes the new center point in the Viewing window.

Zoom in and out of a specific area

When you select a specific area, you can zoom in or out of the area to change the viewing details.

1. On the ECAD Viewing toolbar, click Zoom Area .

Inside the Viewing window, your cursor appears as a magnifying glass.

2. Draw a rectangle around the desired area.

Tip:

Once the Zoom area is selected, you can zoom in or out of the area and you can pan (move)
the image using your mouse. On the ECAD Viewing toolbar, click Zoom  and move the
cursor up and down to change the zoom. To pan the image, press the Shift key and move the
cursor.

Zoom by incremental amounts

On the ECAD Viewing toolbar, select one of the Zoom tools.

• Click Zoom In  one or more times.

3. Viewing ECAD documents
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The image is increased by incremental amounts.

• Click one or more times on Zoom Out  one or more times.

The image is decreased by incremental amounts.

Working with advanced ECAD viewing options

Working with advanced viewing options

ECAD documents can consist of numerous elements and objects. As a result, tasks such as viewing
specific PCB sides, navigating nets, highlighting specific objects, searching for and finding object
instances and object names are critical to the PCB design and review process.

View the opposite (top or bottom) side of the PCB

Use View Opposite Side  to switch between the top and bottom panels and lock the layers
associated with the opposite panel.

On the ECAD Base toolbar, do one of the following:

To do this Use this option

View the top panel.

The top panel is displayed and the bottom panel
layers are locked.

Turn off View Opposite Side 

View the bottom panel.

The bottom panel is displayed and the top panel
layers are locked.

Turn on View Opposite Side 

Note:

Schematic design does not support this option.

View the top and bottom side of the PCB

Use View Top and Bottom Side  to switch between locking and unlocking the opposite panel.

On the ECAD Base toolbar, do one of the following:

Working with advanced viewing options
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To do this Use this option

View both the top and bottom panels.

The top panel is forward (closest to you) and the
layers are unlocked.

Turn on View Top and Bottom Side  and turn
off View Opposite Side 

View both the top and bottom panels.

The bottom panel is forward (closest to you) and
the layers are unlocked.

Turn on both View Top and Bottom Side  and
View Opposite Side 

Note:

Schematic design does not support this option.

Navigate nets and page connectors

PCB boards and schematic representations can be saturated with ECAD elements. It can be difficult
to follow the direction and details of nets on your ECAD document. Using net navigation, when you
highlight a net, a marker displays on a navigation point of the net. You can then navigate along the
net moving the marker from key point to key point. When navigating nets on the schematic, you can
navigate to different pages, depending on the course of the net.

1. In the Assembly view, select the desired net.

2. On the PCB Base toolbar, select either Next  or Previous .

3. (Optional) Use these same navigation steps when the schematic design contains a page connector.

Tip:

Use keyboard shortcuts to move to the next or previous net by using the N or P keys.

3. Viewing ECAD documents
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Example:

Note:

When net navigating, you may navigate to an object that is located on a layer that you have
configured as invisible. The object displays in the layer color you previously configured for invisible
layers.

Highlight and center component objects

In the Assembly view, select a PCB object (a component, net, pin, part data, or shape).

The object is centered and highlighted in the Viewing window and highlighted in the Assembly view.

Tip:

You can also browse over objects to highlight and identify details about them.

Find instances of part data and shapes

At times, one object will represent several instances when you view an ECAD document. For example,
both part items and shapes can be repeated in a document as multiple components. You can use the
shortcut menu to display all instances of these objects.

1. In the Assembly view, select a PCB shape or part data.

2. Right-click and select Instances.

3. (Optional) Highlight one or more instances contained in the Instances dialog box.

The object is highlighted and centered in the Viewing window.

Highlight and center component objects
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4. (Optional) Double-click an instance of interest or click Attributes to view the attributes of the
object.

Tip:

You can also browse over PCB objects to highlight and identify details about them.

Display file properties

Use Properties to display important data and information about the metadata associated with the basic
PCB or schematic file.

On the ECAD Base toolbar, click Properties .

The Properties <file name> dialog box appears with metadata about the ECAD document.

Note:

The Properties dialog box displays the following metadata:

• Design of the document

• The description of the document

• The creator of the document

• The date the document was created

• If the document was modified, the name of the person who modified it

• The date of the last modification

• Revision status

• The dimensions of the document

• The unit of measurement

• The read/write status of the document

Display object attributes

You may find it helpful to quickly view details about component attributes associated with the opened
ECAD document. For objects that support attributes, you can highlight the object in the Assembly view
and the object is highlighted and centered in the Viewing window.

3. Viewing ECAD documents
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Right-click a selected object in the Assembly view and select Attributes.

The Attributes dialog box displays the attributes of the selected object.

Note:

Not all objects support attributes, for example, header objects such as the introductory nets.

Display object names

1. On the ECAD Viewing toolbar, click Browse .

2. Move your cursor over the object and its name is displayed in a text box.

3. (Optional) Click an object in the Viewing window to highlight it on the PCB or schematic as well as
in the Assembly view.

4. (Optional) Double-click the object in the Viewing window to highlight it and to open the Attributes
dialog box.

The Attributes dialog box displays additional data and information about the object.

You can also select an object in the Assembly view to highlight and center it in the Viewing window.

Searching ECAD documents

Overview of searching ECAD documents

Use search tools to find components, nets, pins, and more. Objects that match your search conditions
are displayed in the Objects found section of the Search dialog box.

Use standard search tools to create the search using saved search filters or using specific object types and
then entering search criteria.

Use advance search tools to create searches using filters. You can create, edit, and delete search filters.
Use filters to specify greater search details for various objects or for detailed conditions. For PCB design
files, for example, you can set the board side for the search. Or, for both PCB and schematics you can set
or restrict the rotation orientation of the object.

For both standard and advanced searches, when you highlight objects in the Objects found section
the objects are also highlighted in the Viewing window. You can also double-click an element in the
Objects found section to display its attributes in the Attributes dialog box. If attributes do not exist for
an object, the dialog box is empty.

Display object names
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Standard searches

1. On the ECAD Base toolbar, click Search .

2. In the Search dialog box, from the Saved Filters section, accept the default filter.

If you have previously created and used advance searches, saved search filters are also available.

3. In the Simple Search Type section, select an ECAD object for your search.

4. In the Search for section, type additional details for your search.

Tip:

• Wildcard symbols are supported.

• Use the semicolon to add a series of objects to your search. For example, C100;C105.

• To search for all possible conditions, in Search for, type an asterisk.

5. Click Search.

Objects that match your search are displayed in the Objects found section of the dialog box.

6. (Optional) Click an object in the Objects found section.

The object is centered and highlighted in the Viewing window, and it is highlighted in the
Assembly view.

7. (Optional) Click Highlight All to highlight all objects in the Objects found section.

Advanced searches

1. On the ECAD Base toolbar, click Search .

2. In the Search dialog box, click Advanced.

3. (Optional) In the Saved Filters section, select the name of a saved search filter.

The filter values appear in the Filter section. You can run the search, create additional filter
conditions, or delete filter conditions.

3. Viewing ECAD documents
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Tip:

In the Saved Filters section, click Delete to remove the saved filter data.

4. In the Edit Filter section, select an ECAD object from Type.

Note:

Optional filter conditions are associated with the ECAD object selected in Type. For example,
if you select Components, component filter conditions are displayed. If you select Nets, net
filter conditions are displayed.

5. In the Filter section, select Filter and then click Create.

6. In the Edit Filter dialog box, select the Criterion and search values for the search type.

7. (Optional) To add search filters to your search do the following:

• Highlight a filter and click Create.

• In the Edit Filter dialog box, select the Criterion and search values for the search type.

• Repeat these steps for additional search conditions, making sure that you highlight the correct
filter for the desired search outcome.

Example:

For these examples, open the demo.xfatf file.

To create this
search Do this

Search for all nets
named 27* AND
those nets with 9
or less pins.

a. Highlight Filter and then click Create.

b. In the Edit Filter dialog box, select Net and in the value
section type #27*.

c. Highlight NET.NAM=#27*, and click Create.

d. In the Criterion section, select Number of pins, and then
select the less than symbol. Next, select 9.

e. Click Search.

The search results appear in the objects found section.

Advanced searches
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To create this
search Do this

The filter structure should look like the following graphic.

Search for
a component
named C10 OR
all components
starting with the
letter T.

a. Highlight Filter and then click Create.

b. In the Edit Filter dialog box, select Component Name and
then select C10 from the list.

c. Highlight Filter again, click Create, and then type T* in the
value section.

d. Click Search.

The search results appear in the objects found section.

The filter structure should look like the following graphic.

Search the top
side for shape
names CC7343*
AND an object
with part number
J12555–12, OR
a shape named
object PIN*.

a. Highlight Filter and then click Create.

b. In the Edit Filter dialog box, in Criterion, select Side from
the list, and then select Top from the list.

c. Highlight CMP.Side=Top, click Create, then select Shape
Name in the Criterion section. Scroll to CC7343, and add
an asterisk to CC7343.

3. Viewing ECAD documents
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To create this
search Do this

d. Highlight SHP.NAM=CC7343*, click Create, and then select
Part Number from the Criterion section. Scroll to J12555–
12 and click OK

e. Highlight CMP.SIDE=Top again, click Create and add Shape
Name from the Criterion list. Then, type PIN* in the value
section.

f. Click Search.

The search results appear in the objects found section.

The filter structure should look like the following graphic.

8. (Optional) To modify an existing filter, highlight the filter and click Edit, and make changes in the
Edit Filter dialog box.

9. (Optional) Click Delete to remove a search filter and its child filters.

10. (Optional) Click Clear to remove all filters.

11. (Optional) Click Save to save the conditions of this search.

Type the name of the saved search filter. The name appears in the Saved Filter section.

12. Click Search.

Objects that are found in the search are displayed in the objects found section of the Search
dialog box.

Advanced searches
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Note:

• The first object that is found is highlighted in three different locations: in the objects
found section, in the Viewing window, and in the Assembly view.

• Double-click an object in the objects found section and the Attributes dialog box displays
the attributes associated with this entity.

13. (Optional) Click Highlight All to display all objects found in the Viewing window.

The objects found are not highlighted in the Assembly view.

Use search preferences to change unit values

Search preferences consist of established unit values. Unit measurements include resistance,
capacitance, voltage, and current, among other units. Each unit has standard values. For example, for
resistance ohm, kohm, and mohm, values are automatically provided. Use search preferences to edit,
delete, and add unit attributes and their values.

Caution:

Unit definitions and values are PCB board and schematic dependent. If you want to include unit
measurements in your search, you must create unit definitions and values if they are not already
included in the preferences.

3. Viewing ECAD documents
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1. Open an ECAD document.

2. Right-click in the Viewing window and select Preferences.

3. Click the Search tab.

4. Highlight the unit attribute of interest, and click Add and then, in the Unit Preference dialog box,
define the new attribute and its values.

5. (Optional) Highlight the unit attribute of interest, and click Edit and then, in the Unit Preference
dialog box, make changes to available fields.

6. (Optional) Click Delete to remove the attribute.

Use search preferences to change unit values
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Example:

The example uses the file demo.xfatf.

This search looks at the Top side of the board for part attributes with a tolerance that is less than
or equal to 5%, and a value greater than or equal to 1k (1kilo ohm).

Since many of these search values are not defined in established search preferences, you need to
add them.

1. Open Preferences and click the Search tab.

2. Highlight Resistance and click Add.

3. Type the following values:

• In Unit, type k.

• In Multiplicator, type 1000.

• In Description, type kiloohms.

4. On the ECAD Base toolbar, click Search .

5. In the Search dialog box, click Advanced.

6. Process the advance search using the following search structure:

• For Part Attribute values for TOL, follow this example:

3. Viewing ECAD documents
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• For Part Attribute values for VAL, follow this example:

Change the color of a layer

1. On the ECAD Base toolbar, click Layer Color .

2. From the Layer Color dialog box, highlight the desired layer.

3. From the Color list, choose a layer color.

4. Do one of the following:

• Click Apply to make your change and to keep the Layer Color dialog box open for more changes.

• Click OK to make change and close the Layer Color dialog box.

Note:

Click Default Colors to reset layer colors to their initial state.

Change the visibility state of a layer

Modify the visibility state of a layer in one of these ways:

Change the color of a layer
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From the Do this

ECAD Layer
view

Select or clear the active layers check box  to hide or make visible the desired layer.

Note:

To hide all layers clear the top node check box  in the ECAD Layer view.

ECAD Base
toolbar

1. Click Layer Color .

2. From the Layer Color dialog box, highlight the desired layer.

3. Click Visible/Invisible to specify your change.

4. Select Apply visibility changes to markup layers.

5. Do one of the following:

• Click Apply to make your change and to keep the Layer Color dialog box open
for more changes.

• Click OK to make your change and to close the Layer Color dialog box.

ECAD Layer
view

Select or clear the active layers check box  to hide or make visible the desired layer.

Note:

To hide all layers clear the top node check box  in the ECAD Layer view.

Note:

All layers must have a color property even if you set the layer to invisible. You may need to display
objects even if they are on invisible layers.

Specify ECAD viewing preferences

Use options in the Preferences dialog box to specify default viewing behavior.

1. Right-click anywhere in the Viewing window, and choose Preferences.

2. In the Preferences dialog box, click the View tab and do one or more of the following:

3. Viewing ECAD documents
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Use this option To do this

Show border Display or hide a border surrounding the document.

Flip mouse direction
for zoom

Specify how you use the mouse to zoom in the Viewing window.

Note:

The default behavior for Zoom  is to zoom out by dragging up
and zoom in by dragging down. You can reverse this behavior by
selecting this option. The option also reverses the direction you
roll the mouse wheel to zoom in or out.

This one preference affects zooming in 2D and 3D Viewing
windows.

Background Color Specify the background color on which the document is displayed.

Feedback Color Specify the color that appears when you initiate adding a markup or
when you highlight an area to zoom.

The initial default feedback color is red.

Initial View Rotation Select how you want to rotate images when you open them in the
Viewing window.

Choose one of the following options:

• No Rotation

• 90 Degrees CW

• 90 Degrees CCW

• 180 Degrees

Initial View Mode Specify the default view mode.

The initial default view mode is Pan.

Units Specify the default unit of measurement.

3. Click Apply.

Configure loading preferences

Use options in the Preferences dialog box to specify default loading characteristics. These preferences
are used to determine how you want files to be opened.

1. Right-click anywhere in the Viewing window, and click Preferences.

Configure loading preferences
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2. In the Preferences dialog box, click the Load tab and do one or more of the following:

Use this option To do this

Display markups
when loaded

Display all embedded markups on all visible layers when you open the
file.

Note:

Display markups when loaded is the initial default value. When
you clear this setting, markups are loaded but they are not visible.

Show markups as
icons

Display markups as icons when you open a file.

Note:

The default value is to display markups as full text.

Initial Viewport –
Base View

Specify the opening view is set to the Base View.

Note:

Base View is the default value.

Initial Viewport – Fit
All

Specify the opening view is set to Fit All.

Component Origin –
CAD origin

Display the component marker at the origin of the component.

Component Origin –
Component center

Display the component marker at the center of the component.

Font Name Change the font for the text associated with the ECAD document.

Note:

The default font is Hershey. You can use this feature to change the
font to match your locale.

3. Click Apply.

Change the font in ECAD documents

You can change the font in ECAD documents. The default font is Hershey. Use Preferences to change
the text font as needed. You can also change the default font by modifying the Initialization.xml file.

3. Viewing ECAD documents
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1. Right-click anywhere in the Viewing window, and click Preferences.

2. In the Preferences dialog box, click the Load tab.

3. From the Font Name list, select a font.

4. To make the font change take place, close and reopen the ECAD document.

The following snippet uses the zuken.xsch file, which is located in the installation Examples folder.

Hershey font

Times New Roman font

5. (Optional) To change the default font for ECAD documents, do the following:

Change the font in ECAD documents
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a. Navigate to <installation_folder>\Teamcenter9\Visualization\etc and open Initailization.xml.

b. In the ECAD section, change the font value to your new default font.

3. Viewing ECAD documents
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4. Working with 2D snapshots
Overview of working with 2D snapshots

Snapshots capture the current state of your view. A snapshot saves view magnification, position,
orientation, markup layer visibility, and the current page for multiple page images.

Note:

• Snapshots do not save the layer visibility state of images with multiple image layers.

• The shortcut menu option Save as a Teamcenter Snapshot is only available in the Lifecycle
Visualization viewer if you are working with data from Teamcenter.

Snapshots appear as thumbnail images in the Snapshots view.

You can double-click a snapshot to make the current view match the snapshot.

Snapshot commands are in the Snapshots toolbar, in the Snapshots menu, and in the shortcut menu
that you access by right-clicking inside the Snapshots view.

Add a 2D snapshot

1. Manipulate the contents of the Viewing window until you create a view you want to save.

2. Do one of the following:

• In the Snapshots view, right-click and choose Add.

• On the Snapshots toolbar, click Add .

Insert a 2D snapshot

1. Click the Snapshots view to activate Snapshots.

2. In the Snapshots view, select a snapshot.

3. Manipulate the image until the Viewing window displays the view of interest.

4. Do one of the following:

• In the Snapshots view, right-click a snapshot and choose Insert.

ECAD Viewer, Teamcenter 2412  4-1
© 2025 Siemens



• On the Snapshots toolbar, click Insert .

The snapshot is inserted in the Snapshots view before the previously selected snapshot.

Replace one 2D snapshot with another

1. Click the Snapshots view to activate Snapshots.

2. In the Snapshots view, select the snapshot to be replaced.

3. Manipulate the view until the Viewing window displays the view you want to save.

4. Do one of the following:

• Right-click a snapshot and click Replace.

• On the Snapshots toolbar, click Replace .

The selected snapshot disappears and it is replaced by the new snapshot.

Add a name to the 2D snapshot

1. Click the Snapshots view to activate Snapshots.

2. In the Snapshots view, right-click a snapshot, and then click Name.

3. In the Snapshot Name dialog box, in Name, type a new name for this snapshot.

The snapshot name is displayed when you hold the cursor on the snapshot.

Rearrange 2D snapshots

1. In the Snapshots view, click a snapshot and drag it to another position.

2. To drag multiple snapshots, hold Ctrl as you select the snapshots, and then drag the group to
another position.

3. To drag a series of snapshots, hold Shift as you select the first and last snapshots in the series, and
then drag the series to another position.

Delete 2D snapshots

1. Click the Snapshots view to activate Snapshots.

4. Working with 2D snapshots

4-2  ECAD Viewer, Teamcenter 2412
© 2025 Siemens



2. Do one of the following:

• In the Snapshots view, right-click the snapshot and choose Delete.

• In the Snapshots view, select the snapshot you want to delete, and then on the Snapshots
toolbar, click Delete .

Display an existing 2D snapshot

1. Click the Snapshots view to activate Snapshots.

2. Display an existing snapshot in one of these ways:

• In the Snapshots view, double-click the desired snapshot.

• Right-click the snapshot and choose Recapture Image.

The existing snapshot opens in the Viewing window.

Display an existing 2D snapshot
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5. Managing ECAD markups
Overview of working with ECAD markups

Markup tools, developed specifically for the PCB design community, help make collaboration and
communication a reality. In this collaborative industry, you can use markup tools to minimize design
and manufacturing miscalculations by providing comments and suggestions in the review process.
Markup features include robust textual markup options, graphical markups such as lines and shapes, and
important measurement markups, which include distance, radial, clearance, and length measurements.

ECAD markup profiles

Using markup profiles

Use markup profiles to create a set of common markup preferences. Markup profile preferences include
specifying the unique name of the profile and configuring markup appearance preferences for this
profile. For example, during a phase in the design project you determine that you want to collaborate
with design team members, with management, and with a third party. You can create a markup profile
for each group. This helps organize and structure collaboration and communication between these
groups for the lifecycle of the project.

Create a new markup profile

1. On the ECAD Markup toolbar, click Enable Markup .

2. On the ECAD Markup toolbar, click Markup Preference Profiles .

3. In the Markup Profiles dialog box, click Create.

4. In the Create Markup Profile dialog box, do the following:

Use this
option To do this

Profile
name

Enter the name of your markup profile.

Initialize
from

Select an existing profile from the Initialize from list.

Note:

This action sets initial markup preferences. You can later edit these
preferences.
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5. Click OK.

The new markup profile is added to Available Profiles in the Markup Profiles dialog box.

Manage markup profiles

When you manage markup profiles, you can create new markup profiles as well as view, edit, or delete
existing profiles. Markup profiles maintain markup appearance preferences for elements such as line, fill,
and text color.

1. On the ECAD Markup toolbar, click Enable Markup .

2. On the ECAD Markup toolbar, click Markup Preference Profiles .

3. In the Markup Profiles dialog box, do any of the following:

Use this
option To do this

Active Select the active profile from Available Profiles list.

View View the appearance preferences of the selected markup profile.

Edit Edit the appearance preferences of the selected markup profile.

Note:

You cannot edit the default profile.

Delete Delete an existing markup profile.

Note:

You cannot delete either the default profile or the active profile.

Create Create a new profile name and set the markup appearance preferences for the new
profile.

4. Click OK.

The selected markup profile becomes the active markup preferences for future markups.

5. Managing ECAD markups
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Changing the appearance of markups

Once you create a new markup profile, you can accept the default appearance options for specific
markup tools or you can modify the appearance options for each markup tool. Access the Preferences
dialog box by clicking Edit when you select the profile you want to change.

You can modify the following markup options:

Use this option To do this

Line Change line characteristics including style, color, thickness, and leader
markers.

Edge Change how you want the edges to appear by changing the style, size, and
thickness of the edge.

For example, you may want a red edge around an transparent oval.

Fill Change the fill style, color, and select or clear transparency.

Font Change the font name, style, and color.

Predefined text Change several options for setting predefined text.

You can select auto-translation, and the category of predefined text
(electrical, manufacturing, and so forth). Plus, you can create and use your
predefined text.

Measurement Change the size of displayed measurement values (ranging from extra small
to extra large), the color of the text and notation lines, and precision setting
of values to the right of the decimal point (0 to 9).

Text markups for ECAD documents

Using text markups

Text markups provide vital information to other design team members. When you add new text markups
or edit existing ones, you are communicating design direction that improves processing PCBs. Using
predefined text and auto translated messages also improves how you collaborate with others around the
world.

Add a text markup

1. On the ECAD Markup toolbar, click Enable Markup .

Changing the appearance of markups
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Note:

The cursor changes to NoSymbol  until you select a markup tool.

2. On the ECAD Markup toolbar, click Create New Markup .

3. Click in the Viewing window and type a markup topic name in the Markup Topic dialog box.

4. On the ECAD Markup toolbar, click Text .

5. Use the cursor to create a bounding box in the Viewing window, and enter your text message in the
Text Editor dialog box.

6. (Optional) To resize the text bounding box, choose Select Markup , point to the desired
markup, and move the bounding box handles to the desired position.

Note:

You can move the markup after it is placed. First, highlight the markup using the Select Markup
 option, and then drag the bounding box to a new location.

Add predefined text markups

You may find that you are typing the same markup text repeatedly or that you communicate standard
messages during the project. If so, you can automate this process by selecting markup text from an
existing text file.

1. On the ECAD Markup toolbar, click the following:

a. Enable Markup 

b. Create New Markup 

c. Rubber Stamp 

2. From the Rubber Stamp dialog box, select Note file.

You can Browse to an existing predefined note file or you can choose one from the Index or Title
lists.

Example rubber stamp markup file

5. Managing ECAD markups
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Automatically translate text messages

Several standard text messages have been predefined and translated in languages supported by the
software. When you open a document containing a predefined text message, the text of the message is
automatically translated to the default language of the computer that opened the file.

1. On the ECAD Markup toolbar, click Enable Markup .

2. On the ECAD Markup toolbar, click Markup Preference Profiles .

3. In the Markup Profiles dialog box, click Edit.

4. In the Preferences dialog box, click the Predefined Text tab and select Auto-translate text.

5. Choose a general topic from the Category list, and then select a text message from the list of
messages.

For example, automatically translated categories and text messages include the following:

Category Text message

Electrical Traces are too narrow for the power they will carry

Traces are too close together

Traces exceed allowed distance for running together

Traces too close to holes/vias/pads

High voltage/low voltage isolation rule violations

Needs more bypass caps

Test point to Test point spacing

Test point clearance to Component

Clearance to Circuit edge

Inaccessible object

Manufacturing Trace turns too sharp

Missing tear-drops

Missing thermals

Bad or wrong pad stack

Fabrication Object blocking solder wave

Problems with solder mask

Markings/silk screen not to standards

Automatically translate text messages
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Category Text message

Split power plane problems

Questions regarding possible etching undercut on a narrow trace

Mechanical Holes too close to edge

Wrong size holes/drills for specified hardware

Missing features

Physical part interference

Panel width and length

Component Height

Note:

To add this predefined text markup message, add a markup and then on the ECAD Markup
toolbar, click Rubber Stamp .

Add to an existing markup

In a collaborative environment, you may need to provide updated revisions to an existing text or
graphic markup. You can add markup revisions to an existing markup without losing previous markup
information.

1. On the ECAD Markup toolbar, click Enable Markup .

2. On the ECAD Markup toolbar, click Select Markup .

3. In the Viewing window, highlight the target markup.

4. Right–click the markup and select Add Markup Revision.

5. Create your markup using the markup tools.

The target markup and all revisions to it appear as one markup in the Markup Log. These markups
appear in the Viewing window as separate markup entries, but you can view them together as an
icon or as text.

Display predefined text automatically

If you find that you are accessing predefined text options regularly, you can set preferences to always
open the Predefined Text dialog box.

5. Managing ECAD markups
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1. On the ECAD Markup toolbar, click Enable Markup .

2. On the ECAD Markup toolbar, click Markup Preference Profiles .

3. In the Markup Profiles dialog box, select an active profile from Available Profiles and click Edit.

4. In the Preference dialog box, click the Predefined Text tab, and select Display dialog on tool
activation.

Add line or graphic markups

While a text markup is the most common markup, you will find that line and graphic markups can
enhance and clarify your design direction.

1. On the ECAD Markup toolbar, click Enable Markup .

Note:

The cursor changes to NoSymbol  until you select a markup tool.

2. From the ECAD Markup toolbar, click Create New Markup .

3. Click in the Viewing window and enter a markup topic name in the Markup Topic dialog box.

4. Select one or more of the following line or graphic markups:

Use this option To do this

Freehand Line Draw a freehand line.

Leader Line Draw a leader line by doing the following:

a. Click in the Viewing window to place one endpoint.

b. Click to place each vertex.

c. Double-click to place the last endpoint.

Tip:

To make the line exactly horizontal or vertical,
press the Shift key as you drag or click the
mouse.

Add line or graphic markups
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Use this option To do this

Ellipse Draw an ellipse by doing the following:

a. Click in the Viewing window to place the starting
point of the graphic.

b. Drag the cursor to size the graphic as desired.

Tip:

To draw a circle, hold the Shift key as you drag
the cursor.

Polygon Draw a polygon by doing the following:

a. Click in the Viewing window to place one endpoint.

b. Click to place each vertex.

c. Double-click to place the last endpoint.

Rectangle Draw an rectangle by doing the following:

a. Click in the Viewing window to place one corner.

b. Drag the cursor to place the opposite corner.

Tip:

To draw a square, hold the Shift key as you
drag the cursor.

Measurement markups for ECAD documents

Using measurement markups

There are several instances where you need measurement data from the PCB. Measurement tools,
accessed from the ECAD Markup toolbar, provide you with options for distance, radial, clearance, and
length data. You can save these measurement markups to your database or file system and they become
a part of the PCB data session. Measurement tools are even available to you when the PCB has been
checked out by someone else; essentially the PCB is in a read-only state. You can take measurements
when you are viewing a read-only PCB, but you can not save (persist) them.

Measurements are generated when you set beginning and ending markers or points on the PCB.

5. Managing ECAD markups
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Tip:

You can use keyboard keys to quickly modify the markers or points. The Shift key and clicking
creates a vertical measurement. The Ctrl key and clicking creates a horizontal measurement. Use
the Backspace key to remove a marker and return to the initial pointer.

Measuring distance in ecad files

Overview of measuring distances in ECAD files

Distance measurements are taken between two points, between a point and a line, or between two
parallel lines. The points and lines can be snap-to portions of a PCB entity. A snap-to element is the outer
edge of a trace width or a vertex or midpoint of a pad edge. You can also specify a point in free space,
anywhere on the PCB.

When you move your mouse around the PCB, feedback markers are displayed indicating that you are
approaching snap-to points or lines.

Point to Point measurements

Euclidean
Distance

Euclidean Distance is the default, minimum distance between any two points.

Vertical
Distance

Vertical Distance is the between two points when you use the Shift key and click for the
second point.

Overview of measuring distances in ECAD files
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Horizontal
Distance

Horizontal Distance is the between two points when you use the Ctrl key and click for
the second point.

Point-to-Line

Use Point-to-line measurement to determine the distance between the line and a point
formed by a perpendicular line between the point and the line segment. You can
extend the point beyond the actual line segment (a point that appears to be in free
space).

Line-to-Line

Use line-to-line measurement to determine the distance between two parallel lines.

Note:

For line-to-line measurements, non-parallel lines are unsupported pick points.

5. Managing ECAD markups
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Measure distance between points and lines

1. On the ECAD Markup toolbar, click Distance Measurement .

2. Click the beginning measurement point.

3. Click the ending measurement point.

4. (Optional for vertical measurements) Hold the Shift key and click at the ending measurement point.

5. (Optional for horizontal measurements) Hold the Ctrl key and click at the ending measurement
point.

Measuring radials in ECAD files

Overview of measuring radials

Use radial measurement when you want the distance between a ring and circle PCB objects. Rings
can be displayed in different forms, including circular shape with circular hole, circular shape with
polygonal hole, polygonal shape with circular hole, and polygonal shape with polygonal hole. Radial

Measure distance between points and lines
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measurements require just one click on or near a highlighted snap-to point or shape. Three radial
measurements are supported: the hole radius, the ring radius, and the radial width of the ring (the
difference between the outer radius and the hole radius).

For circle entities, only one measurement is supported.

Radial measurements

Circle-to-
Circle ring
measureme
nt

Circle-to-Circle ring measurements occur when your cursor nears the hole edge or ring
edge. When you click while either of these edges is highlighted your result is a radial
circle-to-circle measurement.

Polygon-to-
Circle ring
measureme
nt

Polygon-to-Circle ring measurements occur when your cursor nears the hole edge or
a snap point on the ring edge. When you click under these instances your result is a
radial polygon-to-circle measurement.

Circle-to-
Polygon ring
measureme
nt

Circle-to-Polygon ring measurements occur when your cursor nears a snap point of an
inner shape and its outer edge. When you click under these instances your result is a
radial circle-to-polygon measurement.

Polygon-to-
Polygon ring
measureme
nt

Polygon-Polygon ring measurements occur when your cursor nears a snap point on
either the inner or outer shape. When you click under these instances your result is a
radial polygon-to-polygon measurement.

Measure circle-to-circle radials

1. On the ECAD Markup toolbar, click Radial Measurement .

2. Click the inside edge to measure the radius of the inner circle.

3. Click the outside edge to measure the radius of the entire circle.

4. Click the inside or outside edge while clicking the Shift key to measure the width of the ring.

Example:

Circle-to-Circle

5. Managing ECAD markups
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Measure polygon-to-circle radials

1. On the ECAD Markup toolbar, click Radial Measurement .

2. Click the hole edge to measure the radius of the hole.

3. Click a snap point on the shape edge (vertex or midpoint) to measure the distance between the
center of ring and the selected point on the outer shape.

4. Click a snap point on the shape edge while clicking the Shift key to measure the distance between
the outside edge of the ring to the selected snap point on the shape.

Example:

Polygon-to-Circle

Measure circle-to-polygon radials

1. On the ECAD Markup toolbar, click Radial Measurement .

2. Click a snap point on the hole edge to measure the distance between ring center and selected hole
point.

3. Click the ring edge to measure the radius of the ring.

4. Click either a snap point on the hole or on the ring edge while clicking the Shift key to measure the
radial distance between the selected hole point and ring edge.

Example:

Circle-to-Polygon

Measure polygon-to-circle radials
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Measure polygon-to-polygon radials

1. On the ECAD Markup toolbar, click Radial Measurement .

2. Click a snap point on the hole edge to measure the distance between the ring center and the
selected hole point.

3. Click a snap point on the shape edge to measure the distance between the ring center and the
selected ring edge point.

4. Click a snap point on either the shape edge or the hole edge while clicking the Shift key to measure
the radial distance between the selected hole or ring point and the intersecting point.

Example:

Polygon-to-Polygon

Measuring clearance distances

Overview of measuring clearance distances

Use clearance measurement to determine the amount of minimum distance, or clearance, between any
two PCB objects. When you move the cursor around the PCB, underlying objects are highlighted when
you approach them.

Clearance

Use clearance to measure the minimum Euclidean distance between the two PCB objects.

5. Managing ECAD markups
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Vertical clearance

Use vertical clearance to measure the distance between two objects by using the Shift key while
selecting the second object.

Horizontal clearance

Use horizontal clearance to measure the distance between two objects by using the Ctrl key while
selecting the second object.

Measure clearance distance

1. On the ECAD Markup toolbar, click Clearance Measurement .

2. Click the beginning clearance measurement point.

3. Click the ending clearance measurement point.

4. (Optional for vertical clearance measurements) Hold the Shift key and click at the ending clearance
measurement point.

Measure clearance distance
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5. (Optional for horizontal clearance measurements) Hold the Ctrl key and click at the ending
clearance measurement point.

Measuring traces and vias using Manhattan and Routed measurements

Overview of Manhattan and Routed measurements

Use Manhattan or Routed measurements to measure the distance between various points along traces
and vias associated with the same net. Use snap-to pick points to mark the beginning and ending length
measurement points.

Snap-to points

Choose a length measurement (Manhattan or Routed) and then as you move your cursor over a length
of trace, feedback indicators highlight snap-to pick points. Snap-to points are points of measurement
interest provided by the software. You can measure from one point to the next.

For length measurement, you must click a highlighted snap-to point.

Manhattan length

Use Manhattan length measurement to determine the distance (the sum of the X- and Y-coordinates)
between two selected points.

Routed length

Use Routed length measurement to determine the distance (the sum of each segment length along the
trace) between two selected points.

5. Managing ECAD markups
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Measure traces and vias using Manhattan or Routed measurements

1. On the ECAD Markup toolbar, click one of the following:

• Manhattan Length 

• Routed Length 

2. Move your cursor over the target trace or via and select the beginning snap-to (highlighted)
measurement point, and click.

3. Continue navigating the PCB until you find a feedback highlighted marker for your second
measurement snap-to point, and click.

Save markups

When you update a markup, the update is saved to the current markup dataset. You can also use Save
As to save the markup to a different or new dataset.

Do one of the following:

• To save markups, on the ECAD Markup toolbar, click Save .

• To save markups to a different dataset, on the ECAD Markup toolbar, click Save As .

Note:

• Save and Save As are unavailable if the file is read-only.

• Saved markups are loaded automatically the next time you open the document, though the
markup may not be displayed automatically. Markups are automatically displayed when the file
is opened if Display markups on load is selected.

• You can also save markups as a work session using session files. When you open a session file
your work is restored exactly as you saved it. You can also save your work session as file archives

Measure traces and vias using Manhattan or Routed measurements

ECAD Viewer, Teamcenter 2412  5-17
© 2025 Siemens



used to package your work session using session package. You can then move the zipped work
session from your local file session to any location.

Note:

Saving Design for Manufacturing data as session files or in session packages is not
supported.

You can save Design for Manufacturing outside the session file structure and open this
saved data.

Display the markup as an icon or text

Some PCB and schematic documents can be visually overwhelming because of the number of objects
and details contained on them. When you include markup information, you will add more objects to the
view. To help organize these details you can choose to display markups as an icon and then move the
icon to a desirable location. You can also represent markups as fully expanded text and graphics.

1. On the ECAD Markup toolbar, click Enable Markup .

2. On the ECAD Markup toolbar, click Select Markup .

3. In the Viewing window, use Select Markup to select the desired markup.

4. Right-click the highlighted markup, and select Iconize or Expand.

Unload markups

There may be times when you need to unload the currently active (and saved) markup from the viewer.
You may also need to unload all unsaved markups from the viewer.

Right-click in the Assembly view and select Unload Markups.

The currently saved markup is unloaded from the view. If you have unsaved markups in the view, you are
warned that these markups will be deleted.

Display markup activity

Use the Markup Log to display summary markup information. This information includes the markup
topic, the revision, and the author. You can also create and open markup log reports.

1. On the ECAD Markup toolbar, click Enable Markup .

5. Managing ECAD markups
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2. On the ECAD Markup toolbar, click Markup Log .

The Markup Log dialog box appears.

3. (Optional) If Delete is active, you can delete markups associated with the markup log topic.

4. (Optional) Create Markup Log reports.

Note:

• When you highlight a markup topic, the markups associated with it are highlighted in the
Viewing window.

• After you select Delete, you are asked to confirm your decision.

• All subordinate revisions must first be deleted before you can delete the first revision.

• Click a column label to sort data in the Markup Log dialog box.

• The metadata contained in the markup log is read–only. You cannot write to or edit this
information.

Create a markup log report

1. On the ECAD Markup toolbar, click Enable Markup .

2. On the ECAD Markup toolbar, click Markup Log .

The Markup Log dialog box appears.

3. In the Markup Log dialog box, click Report.

4. In the Report Selection dialog box do one of the following:

a. Select the report creation method by choosing Run report wizard or Use a previously saved
report, and then click Next.

b. In the Report Definition Wizard dialog box, choose or edit the report title and then click
Next.

c. From the list, select or clear the data you want in the report and then click Next.

d. (Optional) Select or edit filters that you want applied to the report. Click Next.

Create a markup log report
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e. In the Enter Name dialog box, enter a name for this report and then click Next.

Note:

You can also click Skip is you want to use the default report name.

f. In the Create Report Output dialog box, select the report output format (HTML, CSV, TXT,
XML), or a custom output, and specify the location for the generated file. Then, click Finish.

Modify markup properties

You can change markup properties (such as fill color, edge, and so forth).

1. On the ECAD Markup toolbar, click Enable Markup .

2. On the ECAD Markup toolbar, click Select Markup .

3. Click the markup you want to modify.

A bounding box appears around the markup indicating the markup has been selected.

4. Right-click the markup, choose Properties, and modify the properties.

Edit markup appearance preferences

Use Markup Preference Profiles to modify markup properties such as line color, font type, and fill color.
These changes will take effect on future markups.

1. On the ECAD Markup toolbar, click Enable Markup .

2. On the ECAD Markup toolbar, click Markup Preference Profiles .

3. From the Markup Profiles dialog box, click Edit.

4. Change the markup appearance using the following options:

On this page Use this option To do this

Line Style Select a line type from the Style list.

Color Select a line color from the Color list.

Thickness Enter a line thickness.

5. Managing ECAD markups
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On this page Use this option To do this

Ends Select start or stop (or both) leader ends. Enter
the leader end width and length.

Edge Edge style Select an edge type from the Edge style list.

Edge color Select an edge color from the Edge color list.

Thickness Enter an edge thickness.

Fill Fill style Select the fill type from Fill style list.

Fill color Select a fill color from the Fill color list.

(Under) Transparency,
select Enable

Specify that your markup fill color will not block
data on the board.

Font Font name Select a font name from the available font list.

Font style Select a font style from the available options.

Color Select the text color from the Color list.

Predefined Text Auto_translatable text
message

Choose from a set of predefined words
and phrases that have been translated for
numerous locales.

Note file Choose a text stamp from preexisting text files.
You can Browse through the existing notes and
then choose a specific note file by selecting the
Index or Title for the note from the list.

Display dialog on tool
activation

Specify the Predefined Text dialog box will be
displayed when you create a text markup.

Edit markup appearance preferences
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6. Using cross probing
Overview of using cross probing

There may be times during the design process where you need to verify similarities of and differences
between the schematic and the PCB, between one PCB and another PCB, or between one schematic and
another schematic. Also, you may need to determine how the board design was implemented. In these
situations, you can use cross probing to find common parts that are included in the objects.

Note:

The frames in this graphic have been arranged to display the benefit of cross probing. The frames
in your default application may be different. You can drag and drop the views and frames in the
user interface as desired.

Cross probe ECAD documents

1. Open the target ECAD documents (PCB and schematic, PCB and PCB, or schematic and schematic)
that you want to cross probe.

2. From the ECAD Base toolbar, click Cross Probe .
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3. (Optional – if you have more than two documents open in the Viewing window) In the Cross Probe
dialog box select the target ECAD documents (PCBs, schematics, or both).

Note:

The Assembly view that is enabled corresponds to the document that is highlighted (either a
PCB or a schematic).

4. Select a component from the Assembly view, or from the Viewing window.

Matching components will be highlighted in both ECAD documents.

Tip:

Most PCB and schematic displays are rich with components. Since it can be difficult to notice all
selected objects, you can change the highlight color of the PCB, or the schematic, or both.

1. Select the PCB to give it focus.

2. Choose View→Preferences, and in the View tab select a color from Highlight Color.

3. Repeat these steps for other ECAD documents.

6. Using cross probing
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7. Comparing ECAD documents
Overview of comparing ECAD documents

You can use this feature to open and examine differences in schematic and PCB documents. You can
open any combination of the following ECAD documents:

• Two different PCB revisions.

• Two different schematic revisions.

• A PCB design and its associated schematic.

As examples, you can use compare feature to understand and visually inspect the differences in
component strength, placement, or currency between one revision of the schematic design to another.
Or, you can use the feature to validate ECAD objects contained in the physical design against objects
contained in the accompanying schematic design.

Depending on which ECAD document combination you select, specific preferences are available to help
narrow your results. For example, if you are comparing two PCBs, you can choose to compare both sides
of the board or you can narrow the results by selecting just one side to compare.

The two documents that you want to compare are visually displayed in the Viewing window. The
compare results are also displayed in the Compare view.

You can also modify how compare results are displayed in the Viewing window by modifying compare
preferences. For example, you can change highlight colors, how the two documents are displayed in the
Viewing window, and specifying which ECAD objects and their variables that you want compared.

You can also generate comparison reports, choosing from a variety of output options including HTML
and TXT.

Compare ECAD documents

1. Open two ECAD documents to compare.

2. On the ECAD Base toolbar, click Visual Compare .

3. (Optional) If more than two ECAD documents are opened, in Compare View, select the two
documents that you want to compare.

4. (Optional) If both documents are PCB boards, in Board Side, select Both, Top, or Bottom to specify
how you want to compare the board.
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5. If you are satisfied with the default compare settings, click Compare.

The ECAD documents appear in the Viewing window and the compare results appear in the
Compare view.

6. (Optional) Click More and select options and values for detailed processing, and then click
Compare.

Note:

• The values and options you select are used for this processing session. If you want to save
these options for future processing, click Save As Default.

• The ECAD documents are displayed in the Viewing window in accordance with the
compare configuration preferences you set. By default, the compare results are displayed
with red highlight and the documents are tiled horizontally.

7. Comparing ECAD documents
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Display compare results

General compare results are displayed on the Compare view, and in the Viewing window.

To display only the differences between ECAD documents, In the Compare view, select View
Differences from the shortcut menu.

Example:

This example shows general differences.

Display compare results
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Example:

This example shows just the differences.

Note:

• Notice that all layers are turned off in this view. To return to the previous viewing mode, select
Reset Visibility State from the shortcut menu.

• Highlight any one entity in the Compare view, and that entity is displayed in the Viewing
window.

Change compare preferences

1. Open an ECAD document, and then in the Viewing window, right-click and select Preferences.

2. In the Preferences dialog box, select the Compare tab.

3. From the Compare Color list, choose a highlight color.

Note:

Red is the default color.

4. From the Compare Type list, choose Schematic or PCB.

7. Comparing ECAD documents
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The available list of objects and their compare values depend on the type of ECAD document you
select.

5. In the Objects section, choose the ECAD objects and their attributes that you want to include in the
compare process.

6. (Optional) Specify how you want to display your ECAD compare documents by selecting or clearing
the Tile Compare Windows check box.

Selecting the check box tiles the documents and clearing it removes tiling.

7. (If you tile documents) Select the Horizontal or Vertical check boxes.

Generate compare reports

1. On the ECAD Base toolbar, click Create Report .

Note:

You must have previously generated compare analysis for ECAD documents.

2. In the Report Template section, select ECAD Compare Report.

3. Click Run to create the compare report.

4. (Optional) Choose an output format from the Standard report output format section.

You can choose from HTML, CVS, TXT, or XML.

5. (Optional) Select Custom report output format and then use Browse to navigate to an
appropriate stylesheet location.

6. (Optional) In the Specify a location for the report output file section, click Browse to specify the
location to save the output file.

7. (Optional) Select or clear the Automatically open report output file check box.

8. Click Finish.

9. Optionally, you can also

• Click Customize to open the Report Definition Wizard and customize the report template.

• Click Preview to open a preview view of the generated report.

Generate compare reports
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8. Working with Design for Manufacturing
Overview of working with Design for Manufacturing

Design for Manufacturing consists of performing two critical examinations during the PCB design
lifecycle: Design for Assembly (DFA) and Design for Test (DFT).

Design for Assembly

Use Design for Assembly to manage an analysis of your PCB designs against a default or customized set
of manufacturing rules.

Analyzing results against these rules, DFA highlights problem issues that relate to panel dimensions and
clearances, fiducial quantity and clearance, circuit edge clearance, component-to-component clearance
and height of placed components.

You can establish custom rules that apply to different manufacturing facilities. Each facility may support
a different set of rules and assembly processes. Each team can define the severity of problem issues. For
example, the number of fiducials used for a given circuit length may warrant a warning for one facility
process, but result in a violation for another. A warning notification typically alerts the PCB designer to
less than optimal situations that require communications to the manufacturing engineer prior to release.
Violation level notifications usually require extra or manual processing.

Design for Test

Use Design for Test to examine the integrity of various access points on the PCB. You can select various
DFT rules to use in testing, but the master rule, Basic Access Checking, is the minimum rule that can
be processed. This rule provides a complete analysis of the PCB to inventory all possible predefined
access points. Access points include vias, pins and pads, and test points. DFT testing results provide data
about the access clearance between various ECAD objects. During testing of the physical PCB, test pins
touch and generate specific electrical current to determine if the elements are designed and functioning
properly.

DFT testing provides data to review and repair critical access distance before the PCB goes to
manufacturing.

Processing the analysis

Processing either DFA or DFT analysis begins with using options associated with the DFx toolbar. When
you run DFA and DFT, both their rules and the results are displayed on the ECAD DFX view. The results
are organized and shown as warnings or as violations. You can view the exceptions in the Results
section in the ECAD DFX view. When you highlight an object on the DFx page, the object is also
highlighted and centered in the Viewing window.
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Providing you want to maintain your results, make sure to save them before leaving the Design for
Manufacturing session. You can save results to a new dataset (ECADDFx) in the database. The Rule file is
saved to \Documents and Settings\<User>\Application Data\Teamcenter\DFx.

Note:

We do not recommend that you save custom rules to the default rules file. Your organization may
need to update the default rules file and then push it to all local machines. This process overwrites
your custom rules file if you save it as the default rules file.

Review the DFx graphics associated with the views to understanding of the purpose of the displayed
objects.

Run Design for Manufacturing analysis

1. Open an ECAD document.

2. On the ECAD DFx toolbar, click Open Rules File .

3. In the Open Rules dialog box, select a rules file and click Open.

4. On the ECAD DFx toolbar, click Run DFx Rules .

5. (Optional) View the results of the DFx analysis by navigating to the ECAD DFX view.

6. (Optional) To open previously saved Design for Manufacturing results, on the ECAD DFx toolbar,
click Open Results File .

8. Working with Design for Manufacturing
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Results are saved to any location on your local file system. Result files include a .xres file extension.

Note:

• You can use the default rules to effectively determine the values and thresholds of your PCB. You
may also find it useful to create customized rules for design analysis.

• When you change a preference in the rules file, you should rerun the test. For example, if you
change the highlight color for violations, the change is automatically displayed in the Viewing
window and in the ECAD DFX view. Still, rerunning the test is recommended.

• When you change rule files, all test data is automatically removed from the Viewing window and
in the ECAD DFX view. Rerun the test to display the new visual results.

View Design for Manufacturing test results

1. Navigate to the ECAD DFX view.

2. In the ECAD DFx view, do any of the following:

a. Select or clear specific rules of concern.

The displayed results showing warnings or violations, if any, are also selected or cleared.

Tip:

To help organize the data, you can select or clear rules and collapse or expand the rules
and results.

View Design for Manufacturing test results
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b. To review the severity classification, the description of the test, and the expected default or
user determined value, expand the rule by clicking the plus sign to the left of the rule.

c. To review the test results, including the actual measured value against the predetermined
threshold value, expand the result by clicking the plus sign to the left of the result.

Note:

The severity in this instance is classified as a violation, the PCB element text is red
(the violation color of this system), and the measured value is 15.251600 against a
threshold value of 14.000000.

d. Click a tested object in the ECAD DFX view and the object is highlighted and centered in the
Viewing window.

Note:

The severity in this example is classified as a warning. The text and object colors reflect
warning colors for this system, and actual and expected values are also displayed.

Tip:

For complex PCBs, the ECAD object may not be readily visible in the Viewing window.
Since the object is centered in the Viewing window, you can use the cursor to zoom into
the design until the object is visible.

8. Working with Design for Manufacturing
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You can also view attributes of the object by clicking the Browse . Move the cursor
around the Viewing window and ECAD object names are displayed. Click an object and
review the attributes in the Attributes dialog box.

Save Design for Manufacturing rules and results

1. Run the DFx test.

2. Do one of the following:

• On the ECAD DFx toolbar, click Save .

For Lifecycle Viewer, if you are working with existing DFx files, the DFx files are saved using the
same file name. Otherwise, the Save As dialog box appears.

• On the ECAD DFx toolbar, click Save As .

In the Item Revision dialog box, type the name of the dataset.

Generate Design for Manufacturing reports

When you launch a new design analysis, both the summary and detailed reports are automatically
available. When you choose one of these reports, it opens automatically in your browser. You can also
open these reports for tests that you have saved.

Do one of the following:

• For a summary report, on the ECAD DFx toolbar, click Display DFx Summary Report .

The report opens in your browser.

Save Design for Manufacturing rules and results
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• For a detailed report, on the ECAD DFx toolbar, click Display DFx Detail Report .

The report opens in your browser.

8. Working with Design for Manufacturing
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Note:

The Summary DFx Report provides the following information:

• The PCB name that is being analyzed.

• The file name of the rules file.

Generate Design for Manufacturing reports
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• DFA results.

• DFT results.

• The list of processed rules.

• The status for each rule. Rule status is either active or inactive.

• The number of violations or warnings.

The Complete DFx Report provides the following information:

• The PCB name that is being analyzed.

• Time and date.

• The file name of the rules file.

• The unit of measurement used in the results.

• DFA results.

• DFT results.

• The list of processed rules.

• For Basic Access Checking, Probe Access Checking, and Probe Access Checking by Priority
list the nets that are not accessible.

• For Probe Access Checking by Clearance, list of nets that are not accessible and explain for
each one the expected minimal clearance and the best possible clearance.

• For Conditional Number of Access per Net, list non–accessible nets with the information of
maximum number of possible accesses based on clearance or and priority constraints.

• The status for each rule. Rule status is either active or inactive.

• The number of violations or warnings.

Create and save Design for Manufacturing custom rules

You can customize the attributes of existing DFM rules that are used in an analysis. You customize the
attributes of analysis rules to better define manufacturing rules for your facility or environment. For
example, you can change the severity level (violation or warning) of the rule, and you can change the

8. Working with Design for Manufacturing
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value of the rule. You can also select or clear each rule in the Design for Assembly or Design for Test
section of the DFx Rule Set Editor.

1. Open an ECAD document.

2. On the ECAD DFx toolbar, click Open Rules File .

3. To open the DFx Rule Set Editor, Click Edit Rules File .

Create and save Design for Manufacturing custom rules
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4. Double-click a rule or a sub-rule of interest and its dialog box opens. Do the following:

a. (Optional) In the Priorities section, review the text in the Description section to understand
what will be tested.

In the Parameters section, you can also review a definition of specific rules.

b. (Optional) In the Priorities section, select Violation or Warning.

c. (Optional) Double-click the parameter to open the Edit dialog box.

d. (Optional) Type a new value and click OK in the Edit dialog box and in the rule or sub-rule
dialog box.

5. In the DFx Rules Editor dialog box, click Save .

6. In the Save Rule Set as Template dialog box, type the rule file name and click OK.

Configure Design for Manufacturing preferences

You can use preference options to specify default Design for Manufacturing preferences. You can set
warning and violation highlight colors, and specify Design for Assembly and Design for Test preferences.
For example, DFA preferences include specifying leading edges, solder process, and prefix attributes,
while DFT preferences include changing the color and symbol of your probing tools.

8. Working with Design for Manufacturing
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1. Open an ECAD document.

2. On the ECAD DFx toolbar, click Open Rules File .

3. To open the DFx Rule Set Editor, Click Edit Rules File .

4. Double-click Preferences.

Configure Design for Manufacturing preferences
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5. In the Preferences dialog box, navigate to the one of the following tabs:

• General

• DFA

• DFT

Review the definition of each attribute.

6. (Optional) To change the value of the attribute, double-click the attribute value and make your
changes.

7. Click OK.

8. Working with Design for Manufacturing
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Note:

(Optional) You can modify the description of the rules by double-clicking the rule name. Type your
changed text in the Description section of the Rule Set Information dialog box.

Overview of Design for Test rule definitions and dependencies

DFT rule definitions

Basic Access Checking

This rule performs a complete analysis of the PCB to inventory all possible access points. This is the
minimum rule that is executed with DFT. Other rules cannot be processed without running this rule.
You cannot change parameters of this rule, such as constraint clearance or conditional number of
access per net.

Probe Access Checking

This rule uses access points to check component accessibility. The rule does not require you to define
the priority between access points or to define clearance between probing tools. The processing only
checks if the net can be accessed through any of pre-defined access types (via, pin/pad and test
point) according to their parameters. You must also select Basic Access Checking.

Probe Access Checking by Priority

Overview of Design for Test rule definitions and dependencies
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This rule checks that components can be accessed by following a priority order of access. For
example, you might define processing to check access first through vias and then check access
through pins/pads. You might also exclude accessibility through defined and specific access points.
You must also select Basic Access Checking.

Probe Access Checking by Clearance

This rule checks component accessibility using access points by applying clearance between probing
tools. Consider this rule more like a constraint applied to the Probe Access Checking or to Probe
Access Checking by Priority. This rule cannot be processed alone.

Conditional Number of Access per Net

This rule defines the number of access per net. These set access elements become specific to a
particular PCB. By default, the number of access per net is set to 1. Consider this rule more like a
constraint applied to the Probe Access Checking or to Probe Access Checking by Priority. This rule
cannot be processed alone.

Dependencies

The Basic Access Checking rule is the master rule. You cannot select other rules if you uncheck this rule.

When you select the Basic Access Checking rule you can then select both the Probe Access Checking
and the Probe Access Checking by Priority rules. Other rules remain unavailable.

When you select the Probe Access Checking rule, all the remaining rules are enabled.

When you select the Probe Access Checking by Priority rule, the Probe Access Checking becomes
automatically unavailable. Other rules remain available.

Working with Design for Test document layers

After DFT processing, you can display two distinct DFT document layers in the ECAD Layers view. These
DFT layers display access testing points that are dependent on the selected DFT rules.

The first layer, All Access Points, represents the complete list of all access points that were found during
testing. This layer corresponds to the Basic Access Checking rule.

The second layer, Constrained Access Points, represents the list of access points once constraints are
applied. This layer corresponds to the other DFT rules, excluding the Basic Access Checking rule.

DFT layers are displayed in the Viewing window and you can clear and select one or both layers.

How access points are displayed is predefined by the application for some rules and open for changing
for others. In the examples that follow, all access points are defined as a green cross and constrained
access points are defined as a red cross.

8. Working with Design for Manufacturing
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Example:

Both constrained and all access points are selected.

All access points are selected.

Constrained access points are selected.

When you view different access points, you may find potential access candidates that were not
generated from tested DFT constraints. You may be able to change the attribute values of the constraint
so that it becomes an available access point for testing.

Change Design for Test document layers

1. Open an ECAD PCB document.

2. Right-click in the Viewing window and select Preferences.

3. In the Preferences dialog box, click the DFx tab.

4. In the DFT Layer Visibility section, clear or select one or both of the following:

• Turn ON All Access Points

• Turn ON Constrained Access Points

Change Design for Test document layers
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The next time you open a PCB, your changes are displayed in the ECAD Layers view.

For DFT document layers details, see Working with Design for Test document layers.

8. Working with Design for Manufacturing

8-16  ECAD Viewer, Teamcenter 2412
© 2025 Siemens



9. Creating reports
Overview of creating reports

As you review and analyze ECAD documents, you may find it useful to generate specific reports for your
records or for collaborate with others. You can generate reports for several ECAD objects (bus, nets,
parts, and so forth) by selecting the report template that meets your needs. You can then customize this
report, and you can preview the report before it is generated. Select the default output formats (HTML,
XML, Text, and CSV), or generate a report based on your own output format.

Note:

You can also generate a markup log report, which may be important and useful when you
collaborate with others.

Select a report template

1. On the ECAD Base toolbar, click Create Report .

2. In the Reports dialog box, from Report Template select the ECAD object for the topic of your
report.

3. (Optional) From the Content section, select All to create a report for all selected object types, or
choose Selected to generate a report for objects that are highlighted in the active ECAD viewing
session.

You can then choose to customize, preview, or run the report.

Note:

Customized report templates are created from an existing report template. You first open an
appropriate report template, and then you customize it to suit your needs.

Preview the report

1. On the ECAD Base toolbar, click Create Report .

2. In the Reports dialog box, click Preview.

The Report Definition Wizard dialog box appears, displaying values that will be included in this
report.
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3. Select Done to return to the Reports dialog box and select another template, run the report, or end
the report session.

4. (Optional) Select Next.

5. (Optional) From the Create Report Output dialog box that appears, select the output format and
the location and file name for the report. Then click Finish.

Run the missing net report

The missing net report requires that you have both a PCB (.xfatf) and an associated Schematic (.xsch) file
open in the Viewing window.

1. On the ECAD Base toolbar, click Create Report .

2. In the Reports dialog box, from Report Template select Missing Nets Report.

3. (Optional) Click Preview.

4. (Optional) In the Available documents to select dialog box, highlight the ECAD file that appears
and then click OK.

5. (Optional) In the Report Definition Wizard dialog box that appears, review the data in this report.

You can cancel the report by clicking Done, or you can go to the Create Report Output dialog box
by clicking Next.

6. Click Run.

7. In the Available documents to select dialog box, highlight the ECAD file that appears and then
click OK.

8. In the Create Report Output dialog box, choose a report output and specify a location for the
report file, and then click Finish.

The report appears in your specified location.

Example:

HTML output of the Missing Net Report.

9. Creating reports
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Run reports

1. On the ECAD Base toolbar, click Create Report .

2. In the Reports dialog box, click Run.

3. In the Create Report Output dialog box, choose an output format from the list.

4. (Optional) In the Create Report Output dialog box, select an output file format and the location of
its style sheet.

5. In the Create Report Output dialog box, Browse to the location and enter the file name for this
report.

6. (Optional) In the Create Report Output dialog box, select or clear the Automatically open report
output file check box.

Run reports
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Customize the report

1. In the Reports dialog box, click Run.

The Report Definition Wizard dialog box appears.

2. Follow the instructions to create your custom report template.

Note:

The report options vary for each ECAD object.

9. Creating reports
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10. Printing ECAD documents
Preview documents before printing

1. On the Printing toolbar, click Print Preview .

A preview of what will be printed appears in the Print Preview dialog box.

2. (Optional) In the Viewing window, manipulate the PCB or schematic as desired for printing.

Changes are displayed in the Print Preview dialog box.

3. (Optional) To change the printer configuration and options, click Setup.

4. (Optional) Click Print.

Print ECAD documents

1. (Optional) Preview documents to review how the document will be printed.

2. On the Printing toolbar, click Print .

3. In the Print dialog box, specify any of the following options:

On this page Choose this option Then do this

Print Name Select a printer to print the documents.

Tip:

Click Properties to view and modify
available printer options.

Default print settings Select one of the following:

• To use the default printer settings, click Print
Defaults.

• To use the printer settings used the last time
you printed, click Last Used.

• To save the current printer settings, click
Save As, and in the Save Settings dialog
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On this page Choose this option Then do this

box, type a name for the printer settings, and
click Save.

Open Documents Select the names of open documents that you
want to print.

Tip:

You can also choose Select None to clear
all selections, or Select All to select all
documents.

If your document is multipaged, you can use
the Page command button to display the Page
Selection dialog box. Use the Print Range to
select the pages you want to print.

Print Layout Orientation Select one of the following page layouts:

• Portrait

• Landscape

• Best Fit

Note:

If you choose Best Fit, all pages print
with the same orientation.

Print Scale Select one of the following print scale options:

• Fit to Page

• 1:1 scale

• Scale

Tip:

Use the arrows to increase or decrease
the scale percentage, or type in a
percentage.

Quality Do one of the following:

10. Printing ECAD documents
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On this page Choose this option Then do this

• Move the slider to improve the clarity or
readability of images previewed or printed.

• Print Image

Moving the slider to the right may improve
the print quality of some images.

• Preview Image

Moving the slider to the right may improve
the readability and clarity of some images.

• Select Auto Calculate Print Quality to
have the software calculate a solid balance
between printing speed and quality for each
print job.

Special Settings Select from the following:

• Select Print as Monocolor to print any image
(color or grayscale) black and white.

• Select Print Full View to always print the
entire image even if you zoom in or out on
the image.

Advanced Image Alignment Specify where you want an image placed
(printed) on the page.

Margins Set page margins before printing.

Treat 2D Vector as Raster Select or clear letting the software handle how
the text is sent to the printer.

Note:

This setting is useful when printing
Vector images that contain font style
and font characteristics that are not
supported by the local computer.

If the Vector image includes a font
style that is not supported by the local
computer, the software tries to select a
close approximation of the font. This may
result in text output that is slightly off.

Print ECAD documents
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On this page Choose this option Then do this

2D Line Font Relative
Spacing

Select this setting to print dashed lines.

Note:

The patterns of font lines are not a fixed
size. They are sized relative to the size of
the output.

MDS File Settings Select Page Centric to set MDS position values
to absolute.

Example:

A starting point for copyright text is set to
one inch from the top left corner of the
page.

The text will always be at this location
regardless of the size of the page.

Select Geometry Centric to scale the location
and size of the text with the rest of the image.

Header and
Footer

Font To make the Header or Footer section available,
select one or both of them.

Click Select Font, and then choose a font
name, style, size, and color.

Header Type the header text in the space provided.

• For additional header options, right-click,
then point to Insert, and then choose one
of following:

• Date

• Time

• File

• Path and File

• UserID

• Page

10. Printing ECAD documents
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On this page Choose this option Then do this

Footer Type the footer text in the space provided.

• To make the Header or Footer section
available, select one or both of them.

• For additional footer options, right-click, then
point to Insert, and then choose one of
following:

• Date

• Time

• File

• Path and File

• UserID

• Page

Watermark Font Select Watermark to make these options
available.

Choose Select Font to select a font name,
style, size, and color.

Select Auto Scale Font Size to automatically fit
the text to the available space.

Watermark Type the watermark text in the space provided.

• For additional watermark options, right-click,
then point to Insert, and then choose one of
following:

• Date

• Time

• File

• Path and File

• UserID

Print ECAD documents
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On this page Choose this option Then do this

• Page

Note:

If the administrator creates an MDS file,
the Watermark option is unavailable.

The button to the left of
Watermark text location

Choose the direction of the watermark text.

Note:

Options include text that is displayed
diagonally, from lower left to upper
right or upper left to lower right, or
horizontally in the center of the page.

Opaque No further action is required.

Note:

An opaque watermark can cover text and
graphics.

Transparent No further action is required.

Note:

A transparent watermark lightly covers
text and graphics. About 50< of the
covered data displays on the printed
document.

Background Color Check Background Color, and then select a
color.

Note:

• By default, Background Color is
unchecked.

• By default, the background color is
white.

4. Click Print.
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11. System administrator reference for
configuring ECAD default preferences
Overview of system administrator configuring ECAD default
preferences

As system administrator, you can modify default ECAD preferences such as viewer preferences, compare
preferences, or cross probe preferences. Your changes affect the default behavior of working with ECAD
files. Default preferences are set values that appear when various viewing dialog boxes are opened.

How to change ECAD default preferences

1. For Teamcenter, your installation created an ECAD Templates in your Home folder. This folder
contains ECAD related templates such as Report and DFX templates. The folder also includes the
Initialization.xml file.

Example:

2. Use a text editor to open, review, and change the values associated with this XML file.

Tip:

For each section that you configure, be sure to configure the OverWrite preference to
“Yes” if the current value is set to “No”.

Here is sample section of an Initialization.xml that shows default ECAD options and their values.

<Section_ECAD>
    <Version value="3" />
    <TextFont overwrite="no" value="Hershey"/>
    <ViewPreferences>
      <!-- OverWriteViewPreferences: "yes" "no" -->
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      <OverWriteViewPreferences state="No" />
      <!-- State Options: "on" "off" -->
      <DisplayMarkupsOnLoad state="on" />
      <MarkupsAsIcons  state="on" />
      <Border  state="on" />
      <!-- InitialBrowseMode Options:"Browse" "ZoomArea" "Seek" "Pan" 
"Zoom" -->
      <InitialBrowseMode  mode="Pan"/>
      <!--  InitialViewPort  Options: BaseView "yes" FitAll "no" -->
      <InitialViewPort  baseView="yes"/>
      <BGColor  red="0xBF" green="0xBF" blue="0xBF" />
      <FBColor  red="0xFF" green="0x00" blue="0x00" />
      <HLColor  red="0xFF" green="0xFF" blue="0x19" />
      <!--Display units  value: "inches" "millimeters" "centimeters" "mils" 
-->
      <Units  value="inches" />
      <!--  Component Marker  value: "origin" "center" -->  
      <ComponentMarker  value="center" />
    </ViewPreferences>
   
    <ViewerPreferences>
    </ViewerPreferences>
    
    <PCBLayerProperties>
      <!-- OverWriteLayerProperties: "yes" "no" -->
 <OverWriteLayerProperties state="Yes" />
 <layer id="ElectricalTop"      on="Yes" red="0x00" green="0x00" 
blue="0x84" />
 <layer id="ElectricalBottom"   on="Yes" red="0x00" green="0x82" 
blue="0x00" />
 <layer id="ElectricalInner1"   on="No" red="0xFF" green="0x00" 
blue="0x80" />
 <layer id="ElectricalInner2"   on="No" red="0x80" green="0x00" 
blue="0x40" /> 
 <layer id="ElectricalInner3"   on="No" red="0xFF" green="0x80" 
blue="0x40" />
 <layer id="ElectricalInner4"   on="No" red="0x80" green="0x80" 
blue="0xFF" />
 <layer id="ElectricalInner5"   on="No" red="0x00" green="0xFF" 
blue="0x40" />
 <layer id="ElectricalInner6"   on="No" red="0xFF" green="0x80" 
blue="0xFF" />
 <layer id="ElectricalInner7"   on="No" red="0x80" green="0x80" 
blue="0xC0" />  
 <layer id="ElectricalInner8"   on="No" red="0x80" green="0x40" 
blue="0x00" />    
 <layer id="ElectricalInner9"   on="No" red="0x00" green="0x80" 
blue="0x80" />
 <layer id="ElectricalInner10"  on="No" red="0x00" green="0x80" 
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blue="0xFF" />
 <layer id="ElectricalInner11"  on="No" red="0xFF" green="0x80" 
blue="0x80" />
 <layer id="ElectricalInner12"  on="No" red="0xFF" green="0x80" 
blue="0x00" />     
 <layer id="ElectricalInner13"  on="No" red="0x00" green="0x40" 
blue="0x40" />
 <layer id="ElectricalInner14"  on="No" red="0xo0" green="0xFF" 
blue="0xFF" />
 <layer id="ElectricalInner15"  on="No" red="0x40" green="0x00" 
blue="0x80" />
 <layer id="ElectricalInner16"  on="No" red="0x80" green="0x00" 
blue="0x00" />
 <layer id="ElectricalCommon"     on="Yes" red="0x84" green="0x00" 
blue="0x84" />
 <layer id="BoardContourCommon" on="Yes" red="0x00" green="0x00" 
blue="0x00" />
 <layer id="DocCommon"           on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="MaskTop"               on="No"    red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="MaskBottom"         on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="AssemblyTop"        on="Yes" red="0x00" green="0x82" 
blue="0x84" />
 <layer id="AssemblyBottom"        on="Yes" red="0x00" green="0x00" 
blue="0x00" />
 <layer id="SilkScreenTop"        on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="SilkScreenBottom"     on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="SilkRefTop"            on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="SilkRefBottom"         on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="PasteTop"            on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="PasteBottom"         on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="CompLabelsTop"        on="Yes" red="0x00" green="0x00" 
blue="0x84" />
 <layer id="CompLabelsBottom"     on="Yes" red="0x00" green="0x00" 
blue="0x84" />
 <layer id="CompCentersTop"        on="No" red="0xFF" green="0x00" 
blue="0xFF" />
 <layer id="CompCentersBottom"     on="No" red="0xFF" green="0x00" 
blue="0xFF" />
 <layer id="PinCentersTop"        on="No" red="0x00" green="0xFF" 
blue="0xFF" />
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 <layer id="PinCentersBottom"     on="No" red="0x00" green="0xFF" 
blue="0xFF" />
 <layer id="CADOriginCommon"     on="Yes" red="0x00" green="0x00" 
blue="0x84" />
 <layer id="BodyLimitsTop"        on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="BodyLimitsBottom"     on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="ReferencesTop"       on="No" red="0x00" green="0x00" 
blue="0x84" />
 <layer id="ReferencesBottom"    on="No" red="0x00" green="0x00" 
blue="0x84" />
 <layer id="TestPointsTop"       on="No" red="0xFF" green="0x00" 
blue="0xFF" />
 <layer id="TestPointsBottom"    on="No" red="0xFF" green="0x00" 
blue="0xFF" />
    </PCBLayerProperties>
    
    <SCHLayerProperties>
      <!-- OverWriteLayerProperties: "yes" "no" -->
      <OverWriteLayerProperties state="Yes" />
 <layer id="ComponentName"      on="Yes" red="0x00" green="0x00" 
blue="0x84" />
 <layer id="SCHPartName"      on="Yes" red="0x00" green="0x00" 
blue="0x84" />
 <layer id="Component"          on="Yes" red="0x00" green="0x82" 
blue="0x00" />
 <layer id="ComponentCenter"     on="No" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="Pin"              on="Yes" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="PinName"          on="No" red="0xFF" green="0x00" blue="0x00" />
 <layer id="PinNumber"          on="Yes" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="GndPower"          on="Yes" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="GndPowerText"      on="Yes" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="Net"                  on="Yes" red="0x00" green="0x00" 
blue="0x00" />
 <layer id="NetName"          on="No" red="0xFF" green="0x00" blue="0x00" />
 <layer id="Bus"              on="Yes" red="0xFF" green="0x00" 
blue="0x00" />
 <layer id="BusName"          on="No" red="0x00" green="0x82" blue="0x84" />
 <layer id="Connector"          on="Yes" red="0x00" green="0xFF" 
blue="0xFF" />
 <layer id="ConnectorName"        on="Yes" red="0x00" green="0xFF" 
blue="0xFF" />
 <layer id="SheetReference"      on="Yes" red="0xFF" green="0x00" 
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blue="0xFF" />
 <layer id="RefName"          on="Yes" red="0xFF" green="0x00" 
blue="0xFF" />
 <layer id="Outline"          on="Yes" red="0x00" green="0x00" 
blue="0x84" />
 <layer id="OutlineText"          on="Yes" red="0x00" green="0x00" 
blue="0x84" />
    </SCHLayerProperties>

    <SCHCompareObjects>    
       <!-- OverWriteSCHCompareOptions: "yes" "no" -->
       <OverWriteSCHCompareOptions state="no" />
       <!-- CompareOptions: on ="1" off="0" -->
       <Component    Name="1" PartNumber="1" SymbolName="1" 
Attributes="1" />
       <Symbol Name="1">
            <Pin Number="1"  Name ="1"/>            
       </Symbol>        
       <PartNumber Name="1" Attributes="1"/>
       <Net Name="1" Connectivity="1"/>
    </SCHCompareObjects>    
   
    <PCBCompareObjects>        
       <!-- OverWritePCBCompareOptions: "yes" "no" -->
       <OverWritePCBCompareOptions state="no" />
       <!-- CompareOptions: on ="1" off="0" -->
       <Contour    BoardContour="1" />
       <Component    Name ="1" Placement="1" PartNumber="1" 
FootprintName="1" 
                Attributes="1" />
       <Footprint Name="1" Body="1">
            <Pin Placement="1"  Number="1" Name ="1"/>
            <Padstack Electrical="1" Assembly="1" Silkscreen="1" 
                Boardcontour="1" DXF="1"
 <Masking="1" Documentation="1"/>
       </Footprint>
       <PartNumber Name="1" Attributes="1"/>
       <Net Name="1" Connectivity="1" Routing="1"/>
       <Via Placement="1" >
           <Padstack Electrical="1" Assembly="1" Silkscreen="1" 
            Boardcontour="1" DXF="1" Masking="1" Documentation="1"/>
       </Via>
       <Other>
           <Padstack Electrical="1" Assembly="1" Silkscreen="1" 
            Boardcontour="1" DXF="1" Masking="1" Documentation="1"/>
       </Other>
    </PCBCompareObjects>

    <ComparePreferences>
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       <!-- OverWriteComparePreferences: "yes" "no" -->
       <OverWriteComparePreferences state="No" />
       <CompareColor  red="0xFF" green="0x00" blue="0x00" />
       <!--  CompareTiling  tile: Vertical-"vert" Horizontal-"horz" -->
       <CompareTiling  tile="horz"/>
    </ComparePreferences>

    <CrossProbePreferences>
       <!-- OverWriteCrossProbePreferences: "yes" "no" -->
      <OverWriteCrossProbePreferences state="No" />
      <!--  CrossProbeTiling  tile: Vertical-"vert" Horizontal-"horz" -->
      <CrossProbeTiling  tile="vert"/>
    </CrossProbePreferences>

    <MarkupProperties>
      <!-- OverWriteMarkupProperties: "yes" "no" -->
      <OverWriteMarkupProperties state="yes" />
      <!-- Line Style Options:
              <0= solid
              <1= dash
              <9= dot
              <10= dashdot
              <11= dashdotdot    
          -->
      <!-- Line Start and End Terminator Options:
              <1= no terminator
              <2= filled arrowhead
              <3= filled circle/ellipse
              <4= inverted filled arrowhead
       <5= "X" terminator
          -->
      <!-- Line Start and End Height and Width Notes:
          <Currently the start and end terminators are sized together 
            according to the values
            <specified by headWidth and headHeight.
      -->
      <Line style="0" thickness="0.01" startTerm="1" endTerm = "2" 
            red="0x00" green="0x00" blue="0x00"
              <headWidth="0.02" headHeight="0.02" tailWidth="0.02" 
                    tailHeight="0.02" />
      <!-- Edge Style Options:
              <0= solid
              <1= dash
              <9= dot
              <10= dashdot
              <11= dashdotdot
       <99= no edge
       -->
      <Edge style="0" thickness="0" red="0x00" green="0x00" blue="0x00" />
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      <!-- Fill Style Options:
              <1= solid
              <3= hatch
              <4= no fill
      -->
      <!-- Fill Hatch Style Options: (applicable only when above 
            Fill Style = hatch)
              <0= no hatch
              <1= horizontal
              <2= vertical
              <3= forward diagonal
              <4= backward diagonal
       <5= crossed vertical & horizontal
              <6= crossed diagonals
      -->

      <!-- Fill Transparency Options: 
        <1.0= transparency; 
        <0.0= opaque   -->
      <Fill style="1" hatch="0" transparency="0.0" red="0x00" 
            green="0xff" blue="0x00" />
      
    <!-- Font Name Options: "name" field includes all style qualifiers 
        of the font appended to the main font name, e.g. "Arial", 
        "Arial Bold", or "Arial Bold Italic". If the font specified by the 
        Font Name field is not installed on the system, this setting is 
ignored. 
          -->
      <Font name="Arial" red="0x00" green="0x00" blue="0x00" />

      <!-- FixedTextType Options: 
        <0= Use Auto-translate text  
        <1= Use Stamp note 
      -->
      <!-- AutoTranslateMsg Options: Index of Auto Translate Message to Use 
-->
<!-- NotesFile Options: Complete Path and Name to Notes File, i.e., 
    c:\notes.txt -->
<!-- NotesIndex Options: Index of Notes File to Use -->
<!-- DisplayOnActivation Options: "yes" "no"  -->
<!-- NotesFile: for demonstration purpose, a sample notes file is provided 
    with each installed product. For example: "C:\Program Files\Siemens\
    Teamcenter[version]\Visualization\Examples\2D\stdnotes.txt"
      -->

      <Text    FixedTextType="0" AutoTranslateMsg="100" NotesFile="" 
NotesIndex="1" 
DisplayOnActivation="yes" />
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      <!-- Measurement Preferences: --> 

      <!-- Size Options: 0=XX-Small  1=XSmall  2=Small 3=Medium 4=Large 
            5=X-Large  6=XX-Large -->
      <!-- DisplayPrecision Options: 0-6; number of digits displayed to 
            right of decimal -->

      <Measurement    Size="3" red="0x00" green="0x00" blue="0x00" 
            DisplayPrecision="2" />
    </MarkupProperties>

    <DFxProperties>
      <!-- OverWriteViewPreferences: "yes" "no" -->
      <!-- Reports: empty strings("") revert to system defaults.  -->
      <OverWriteDFxPreferences state="No" />
      <Reports         DefaultXSL=""  SummaryXSL=""   
DefaultReportOutput=""  />
    </DFxProperties>

    <SearchPreferences>   
    <!-- OverWriteSearchPreferences "yes" "no" -->
      <OverWriteSearchPreferences state="no" />                       
      <!-- For each unit group only one unit should be specified as the 
            default. -->
      <!-- The defaults multiplier should be 1-->
      <Resistance>
<Unit name="ohm"  default="yes" multiplier="1" description="ohms" />
<Unit name="kohm"  default="no" multiplier="1000" description="kiloohms" />
<Unit name="mohm"  default="no" multiplier="1000000" 
description="megaohms" />
      </Resistance>
      <Capacitance>
<Unit name="farad"  default="yes" multiplier="1" description="farad"/>
<Unit name="mF"  default="no" multiplier="0.001" description="millifarad"/>
<Unit name="uF"  default="no" multiplier="0.000001" 
description="microfarad"/>
        <Unit name="nF"  default="no" multiplier="0.000000001" 
                description="nanofarad"/>
        <Unit name="pF"  default="no" multiplier="0.000000000001" 
                description="picofarad"/>
      </Capacitance>
      <Inductance>
<Unit name="henry"  default="yes" multiplier="1" description="henry"/>
<Unit name="H"  default="no" multiplier="1" description="henry"/>
<Unit name="mH" default="no" multiplier="0.001" description="millihenry"/>
<Unit name="uH" default="no" multiplier="0.000001" 
description="microhenry"/>
<Unit name="nH" default="no" multiplier="0.000000001" 
description="nanohenry"/>
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<Unit name="pH" default="no" multiplier="0.000000000001" 
        description="picohenry"/>
      </Inductance>
      <Voltage>
            <Unit name="volt"  default="yes" multiplier="1" 
description="volt"/>
            <Unit name="V"  default="no" multiplier="1" description="volt"/>
      </Voltage>
      <Current>
            <Unit name="ampere"  default="no" multiplier="1" 
description="amp"/>
            <Unit name="amp"  default="yes" multiplier="1" 
description="amp"/>
               <Unit name="A"  default="no" multiplier="1" 
description="amp"/>
      </Current>
      <Power>
            <Unit name="watt"  default="yes" multiplier="1" 
description="watt"/>
            <Unit name="W"  default="no" multiplier="1" description="watt"/>
      </Power>
      <Energy>
  <Unit name="joule"  default="yes" multiplier="1" description="joule"/>
      </Energy>
      <Frequency>
            <Unit name="hertz"  default="no" multiplier="1" 
description="hertz"/>
            <Unit name="Hz"  default="yes" multiplier="1" 
description="hertz"/>
      </Frequency>
      <Time>
<Unit name="s"  default="yes" multiplier="1" description="second"/>
<Unit name="ms"  default="no" multiplier="0.001" description="millisecond"/>
<Unit name="us"  default="no" multiplier="0.000001" 
description="microsecond"/>
        <Unit name="ns"  default="no" multiplier="0.000000001" 
                description="nanosecond"/>
        <Unit name="ps"  default="no" multiplier="0.000000000001" 
                description="picosecond"/>
      </Time>
      <Tolerance>
            <Unit name="%"  default="yes" multiplier="1" 
description="percent"/>
      </Tolerance>
      <Distance>
            <Unit name="in"  default="no" multiplier="1000" 
description="inch"/>
            <Unit name="mils"  default="yes" multiplier="1" 
description="mils"/>
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            <Unit name="m"  default="no" multiplier="39370" 
description="meter"/>
        <Unit name="cm"  default="no" multiplier="393.70" 
                description="centimeter"/>
        <Unit name="mm"  default="no" multiplier="39.370" 
                description="millimeter"/>
      </Distance>
    </SearchPreferences>

  </Section_ECAD>
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